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Preface 

The purpose of this manual is to provide the information to use the latest 
enhancements to the Panel View window in the iCare (BQI) population management 
application. 

This manual contains reference information about iCare views, examples of its 
processes, and step-by-step procedures to show you how to perform activities related 
to the Panel View window in the latest version of the iCare application. 

For more information about iCare basic functionality, iCare usage, or training for 
iCare, you may consult these resources: 

• iCare – Indian Health Service (IHS)/Office of Information Technology (OIT) 
available at http://www.ihs.gov/icare/ 

• iCare Population Management GUI, User Manual Version 2.2 (July 2011) 
available at http://www.ihs.gov/RPMS/PackageDocs/bqi/bqi_022u.pdf 

• iCare Training available at 
http://www.ihs.gov/icare/index.cfm?module=dsp_icare_cmet_training 

• Recorded AdobeConnect sessions for iCare available at 
https://ihs.adobeconnect.com/r6yazmoz1gm 

• Join the iCare listserv by sending an e-mail to icare@listserv.ihs.gov 
 

http://www.ihs.gov/icare/
http://www.ihs.gov/RPMS/PackageDocs/bqi/bqi_022u.pdf
http://www.ihs.gov/icare/index.cfm?module=dsp_icare_cmet_training
https://ihs.adobeconnect.com/r6yazmoz1gm
mailto:icare@listserv.ihs.gov
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1.0 Introduction 
The iCare application is a Windows-based, client-server graphical user interface 
(GUI) to the Indian Health Service (IHS) Resource and Patient Management System 
(RPMS). iCare retrieves key patient information from various components of the 
RPMS database and brings it together under a single, user-friendly interface. The 
iCare application is intended to help providers manage the care of their patients. The 
ability to create multiple panels of patients with common characteristics (e.g., age, 
diagnosis, community) allows users to personalize the way they view patient data. 

The information included in this Panel View specific manual covers iCare Panel 
View functionality in iCare Version 2.6. For more information about iCare basic 
functionality, iCare usage, or training for iCare, you can consult the resources listed 
above in the Preface. 

1.1 Background 
Along with the rest of the healthcare industry, IHS has already developed a set of 
chronic condition management (or register) applications, including for diabetes, 
asthma, and HIV. This type of application provides a way for healthcare providers to 
manage a specific group (register) of patients for a single disease state. Register 
management applications assist healthcare providers to identify high-risk patients, 
proactively track care reminders and health status of individuals or populations, 
provide more standardized and appropriate care by embedding evidence-based 
guidelines, and report outcomes. 

Many patients, however, have more than one diagnosed disease. For instance, at the 
current time within the Indian Health system, a diabetic asthmatic woman could be a 
member of four RPMS registers (diabetes, asthma, women’s health, and 
immunizations). This “silo” approach to patient care could potentially result in 
fragmented care and could increase the risk of inadequate patient care management 
due to misidentification of the true level of risk. 

1.2 iCare Graphical User Interface 
The iCare GUI is intended to allow providers to see a more complete view of patients 
with multiple conditions, while maintaining the integrity of the user-defined, disease-
specific registers. 

iCare can help IHS providers by: 

• Proactively identifying and managing different groups (populations) of patients 
who share user-defined characteristics. 
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• Providing an integrated view of a patient’s conditions that would minimize 
“stovepiped” care management. 

• Providing an intuitive and integrated interface to the diverse patient data elements 
of the RPMS database. 

• Facilitating providers a review of clinical quality of care measures for their own 
patients to enable improvement in the quality of healthcare delivery. 

• Enabling views of traditional healthcare information from the perspectives of 
community, population and public health. 

• Providing the default tag selection as Proposed and Accepted. You can change the 
tag selection for any record by selecting or de-selecting any checkbox. 

• Clicking the “use AND?” check box when there are multiple tags selected. The 
“And” option searches for patients who have ALL of the user-defined tags. 

1.3 Who Should Use iCare? 
Any provider who needs to identify a group of patients for long-term management or 
to create a temporary list should think about using iCare.  

Do you fit any of the following scenarios? 

• I am a nurse at a facility that assigns a primary care provider to each patient. 
Every day, I want to create a list of scheduled patients for two different doctors in 
my clinic. 

• I want to identify which of my patients are considered obese so I can recommend 
nutrition counseling. 

• Because providers at our clinic have performance goals related to annual GPRA 
clinical measures, I want to identify which of my patients are missing key clinical 
data. 

• Our Women’s Health Clinic wants to focus on two clinical performance 
improvement initiatives this year. We want to identify the performance problem 
areas for female patients between the ages of 18 and 50. 

• I am one of two part-time case managers for a group of children, and I want to 
create a patient list that we both can use. 
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2.0 Panel View Window 
The Panel View window displays patient data in a selected panel. Access this window 
by using the Open function or by double-clicking a record on the Panel List window. 

 
Figure 2-1: Panel View window 

Note:  The Repopulate button will not display on the Panel View 
window if the patients in the panel were added manually 
(that is, the panel has no predefined logic). 

The application displays the loading progress (in percentage) in the status bar when 
the panel contains a large number of patients. This feature applies to the Patient List 
(when first accessing the Panel View window), Reminders, Natl Measures, CMET, 
Care Management, and Diagnostic Tags tabs. 

Cancel the loading progress by clicking Cancel; the application displays the Cancel 
display of data? dialog, confirming that the user wants to cancel the loading process. 
Click Yes to cancel the load (otherwise, click No). 



iCare Population Management GUI (BQI) Version 2.6 

Panel View User Manual Panel View Window 
July 2017 

4 

The iCare application allows for more than one user to open the same shared panel 
simultaneously. The second and subsequent users to open the same panel will have 
read-only access to the panel content, similar to Microsoft Word or Excel 
functionality. If the first user closes the panel, the second user will be notified that the 
panel is now available for edit access, unless the user only has Shared Read Only 
access by the panel creator. 

2.1 Information on Toolbar 
The following data displays in the panel information area located between the menu 
bar and the Panel View tabs: 

• Panel Name and Panel Description: both data items are user-defined. 

• Owner Name (only displayed if you are not the creator of the panel): Name of the 
user who created the panel and shared it with you. 

• Total Patients: Number of patients in the panel. 

• Patient List Last Updated: Date and time the Patient List was last repopulated, 
either manually or auto-repopulated. 

• By: Name of user who last repopulated the Patient List. 

Note: If the panel has been shared with others who have 
Read/Write access, the displayed Owner and By fields 
might contain different names. 

2.2 Properties 
Click the Properties button located above the tabs in the Panel Information area (or 
select File | Panel Properties) to view the properties about the current panel. Click 
OK to dismiss the pop-up. 
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Figure 2-2: Panel Properties pop-up 

• The General tab provides information about the panel name, when the panel was 
created and who created it, the panel description, and any filters used to create the 
panel. 

• The Update History tab provides information about the auto-repopulate status of 
the panel, when the panel definition was last modified and who modified it, when 
the patient list was last populated and who modified it, and when the patient list 
was manually updated. 

• The Shared/Access tab provides information about the shared users for the 
current panel and their access rights. 

• The Flag Setup tab provides information about the timeframes for the flag types 
(defined in User Preferences). 

Click OK to dismiss the pop-up. 
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3.0 Patient List Tab 
The Patient List tab of the Panel View window displays data about the patients in 
the panel. The default grid displays the standard demographic columns (Name, HRN, 
Sex, Age, DOB) in addition to the Diagnostic Tag-related data and the condition-
specific (register) fields. 

 
Figure 3-1: Patient List tab 

3.1 Patient List Tab Layout 
Determine the current template in the Patient List tab by reviewing the status bar in 
Current Layout at the bottom of the window. For example, it could read Current 
Layout: System Default. 

The status bar shows information on the rows in the panel. Visible Rows will be a 
smaller number than Total Rows if the user has applied a filter. 

 
Figure 3-2: Status bar row information 
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Users can sort/filter the columns and perform other functions on the columns. 

Table 3-1 provides information on the default columns on the Patient List tab. 

Table 3-1: Patient List columns and information 

Column Information 
Flag indicator  Displays when a patient record has a flag. This column is always the first 

column and can only be removed by turning all flags “off” in the User 
Preferences. 

Feather icon  The feather indicator in this column means that there is an open CMET 
with an overdue step. Go to the CMET Tracked Events sub-tab to review 
this condition. 

Patient Name Required field that will link to the Patient Record if you double-click the 
name. 

HRN Patient’s health record number. The HRN will display as the HRN number 
followed by the facility code. 

Sex F (for female) or M (for male). 
Age Patient’s age. 
DOB Patient’s Date of Birth. 
Designated PCP Designated Primary Care Provider, if any. Not all facilities use this field to 

empanel patients. 
Community Patient’s community of residence. 
Active DX Tags One or more predefined diagnosis definitions (tags) that iCare has 

proposed for the patient that has a Proposed or Active status. Section 
3.1.1 provides more information about Diagnostic Tags. 

 
View the Community alert text by hovering the mouse over the Community Alert  
( ) icon, if any. This icon does not affect the Community column sorting. 

3.1.1 Diagnostic Tags 
The iCare application provides a diagnosis-tagging function that runs as a background 
process on the RPMS server and reviews all patient data. Tagging is a term that refers 
to running a series of logic algorithms on one or multiple patients that identifies (tags) 
them with one or more predefined diagnosis categories, listed below. 

• Asthma 

• COPD 

• Cardiovascular Disease (CVD) Known (CVD Kn) 

• CVD At Highest Risk (CVD AHR) 

• CVD At Significant Risk (CVD ASR) 

• CVD At Risk (CVD AR) 

• Diabetes (DM) 

• HIV/AIDS (HIV) 
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• Hypertension (HTN) 

• Obese 

• Prediabetes/Metabolic Syndrome w/o DM (PreDM) 

• Pregnant 

• Current Smokers (Smoker) 
iCare will classify tags into one of five statuses: Proposed (pending) (P), Accepted 
(A), Not Accepted (NA), No Longer Valid (NLV), and Superseded (S). In the Active 
DX Tags column on any Panel View, the status value should be concatenated with 
the tag name, e.g., Asthma (A), CVD AHR (P), DM (A). 

The detailed logic for each of these diagnosis tags can be found in the Diagnostic Tag 
glossary, which is found on the Tools menu. 

3.1.2 Patient Classified as Sensitive 
Users can identify a “sensitive patient” in the Patient Name column when the name is 
preceded by the sensitive patient ( ) icon. 

When users double-click a sensitive patient record, and if one of the following 
conditions exists: 

• If the patient record is sensitive and the user is not a DG SENSITIVITY key 
holder 
OR 

• If the patient is an employee and the user is not a DG SENSITIVITY OFFICER 
key holder 

Then, the application will display a warning message. 

 
Figure 3-3: Sensitive Patient warning message 

Click Yes to open the patient record. Otherwise, click No. 
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3.2 Patient List Tab Toolbar 

 
Figure 3-4: Patient List tab toolbar 

3.2.1 Add 
Note: Add a patient to the current panel by using the Add 

function or by copying patient data from another panel and 
pasting that data into the current panel. 

Only the panel creator or the shared user with Read/Write access can add patient 
names to the current panel. This is a manual add function. Users can add a patient 
name even if the panel was originally created from a predefined search definition. 
The panel stores the original definition as well as any patients added. This is 
important during the repopulate action. 

Add patient to the Panel View by doing one of the following: 

• Clicking the Add ( ) button 

• Selecting Patients | Add Patient(s) 

• Selecting the Add Patient(s) option on the context menu 
The Select Patients dialog displays. 

 
Figure 3-5: Select Patients dialog 

Use any of the following to search for the patient in the Search field: 

• A few characters of the patient’s last name 



iCare Population Management GUI (BQI) Version 2.6 

Panel View User Manual Patient List Tab 
July 2017 

10 

• The patient’s HRN 

• The patient’s SSN 

• The patient’s Date of Birth 
Next, click Find. The retrieved records will display in the lower panel of the Select 
Patients dialog. Refine the search if needed by using the Search field again. 

Add more than one row at time by selecting multiple rows using Ctrl and Shift keys 
while highlighting the row. 

After highlighting the correct patient(s), click Add to add the patient(s) to the Patient 
List tab on the Panel View window. Otherwise, click Close. 

3.2.2 Open 
The Open function moves the focus to another window where users can view the 
patient record (patient data information stored in the RPMS database). 

Highlight the patient name and open the patient record by doing one of the following: 

• Clicking the Open ( ) button 

• Selecting Patients | Open Patient(s) 

• Selecting the Open Patient(s) option on the context menu 

• Double-clicking the row in the grid 

• Pressing the key combination Ctrl-O 
This action opens the user’s default tab of the Patient Record window. 

By highlighting more than one row, multiple patient records open in individual 
windows. 

3.2.3 Remove 
The Remove function deletes one or more selected patients from the Patient List tab 
on the Panel View window. The removed patients are NOT deleted from the RPMS 
database but are only removed from the panel display. The Remove function is 
limited to the panel creator or the shared user with Read/Write access. 

The panel stores the original definition as well as any patients removed or added. This 
is important during the repopulate action. 

Remove the highlighted patients by doing one of the following: 

• Clicking the Remove ( ) button 
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• Selecting Patients | Remove Patient(s) 

• Selecting the Remove Patient(s) option on the context menu 

• Pressing the Delete key on the keyboard 
After using the Delete function, the Confirm patient remove dialog displays, asking 
the user to confirm removing the selected patients. Click Yes to remove them. 
Otherwise, click No. 

 
Figure 3-6: Remove Patients dialog 

3.2.4 Repopulate 
The Repopulate function rebuilds the contents of the panel. This function reruns the 
panel definition against the cached data (from the nightly job) and adds patients who 
meet the criteria and removes the patients that no longer meet the criteria. The 
Repopulate function is limited to the panel creator or the shared user with 
Read/Write access. 

Note: The Repopulate button will not display on the Panel View 
if the patients in the panel were added manually (that is, the 
panel has no predefined logic). 

Repopulate a panel by doing one of the following: 

• Clicking the Repopulate ( ) button 

• Selecting Patients | Repopulate 

• Selecting the Repopulate option on the context menu 
A warning message displays that asks to confirm updating the patient list: “The 
patient list for this panel may be updated during repopulation and cannot be undone. 
Do you want to continue?” Click Yes to repopulate the panel. Otherwise, click No. 
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Figure 3-7: Repopulate Patients dialog 

After manually editing (adding or removing) patients in the panel, the Maintain 
Manual Changes warning message displays: 

“This panel has been edited manually (patients added or removed). Do you want 
to keep your manual change while repopulating? Answer ‘Yes’ if you want to 
keep the manually addes or removed patients. Answer ‘No’ if you want the 
patient list repopulated.” 

 
Figure 3-8: Maintain Manual Changes dialog 

Click Cancel to cancel the repopulate process. 

Click Yes to repopulate the panel and to keep the manually added or removed 
patients. 

Click No to refresh the patient list. In this case, the patient list will be refreshed: Any 
added patient names will be lost and any deleted patient names will be added back to 
the panel. 

If the user clicks Yes or No, and the current panel contains many patients, iCare 
displays the “Background populate” information message: “Populating the panel 
may take some time. Do you want to run in the background?” Click Yes to run the 
repopulate process in the background. Otherwise, click No to repopulate in the 
foreground. 
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3.2.5 Copy 
The Copy function copies the selected patient’s information to the iCare clipboard. 
The user can then go to another panel view (for a different patient panel) and paste 
the patient’s information. 

Copy the selected patient’s information by doing one of the following: 

• Clicking the Copy ( ) button 

• Selecting Patients | Copy Patient(s) 

• Selecting the Copy Patient(s) option on the context menu 

• Pressing Ctrl-C on the keyboard 
Use the Select All function to select all the patients on the current Panel View 
window. Once the patients are selected, the user can copy and paste them into another 
panel. 

Select all the patients by doing one of the following: 

• Selecting Edit | Select All 

• Using the keyboard combination Ctrl-A 
If you need to deselect the patients, select the Deselect All option on the Edit menu. 

3.2.6 Cut 
The Cut function copies the selected patient’s information to the iCare clipboard and 
removes the selected patient from the current Panel View. The user can then go to 
another panel view (for a different patient panel) and paste the patient’s information. 
The Cut function is limited to the panel creator or the shared user with Read/Write 
access. This function is useful for moving patients from one panel to another. 

Cut the selected patient’s information by doing one of the following: 

• Clicking the Cut ( ) button 

• Selecting Patients | Cut Patient(s) 

• Selecting the Cut Patient(s) option on the context menu 

• Using the keyboard combination Ctrl+X 
Next, move to another patient panel and use the Paste function. 
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3.2.7 Paste 
The Paste function places the contents of the iCare clipboard (such as patient data) 
into the current Panel View (this cannot duplicate patient data). If there are duplicate 
patients in the paste operation, the system displays a message about this condition. 
The Paste function is limited to the panel creator or the shared user with Read/Write 
access. 

Patient records that are pasted into a panel are considered “manually added.” This 
means that they are considered to be members of the panel that were manually 
selected to be on the patient list, and therefore are considered outside of the patient 
list that exists due to the panel’s search logic. 

Paste the contents of the iCare clipboard by doing one of the following: 

• Clicking the Paste ( ) button 

• Selecting Patients | Paste Patient(s) 

• Selecting the Paste Patient(s) option on the context menu 

• Using the keyboard combination Ctrl-V 
The patients on the clipboard are added to the current Panel View. If there are no 
patients on the iCare clipboard, a warning message will display: “There were not any 
patients found to paste, please copy patients using ‘Copy Patient(s)’ or ‘Cut 
Patient(s)’ first.” Click OK to dismiss the message. 

 
Figure 3-9: Unable to find patients to paste dialog 

If the user attempts to paste a duplicate patient, the Duplicate patient message 
displays: “The patient that is being pasted already exists in the panel. To avoid 
duplicate patients, this patient will not be pasted.” Click OK to dismiss the message. 
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Figure 3-10: Duplicate Patient dialog 

3.2.8 Modify 
The Modify function modifies the patient panel definition information. This function 
is limited to the panel creator or the shared user with Read/Write access. 

Modify the current panel by doing one of the following: 

• Clicking the Modify ( ) button 

• Selecting File | Modify 
The Panel Definition window for the panel displays. 

3.2.9 Share 
The Share function defines users who can share the current panel. This function is 
limited to the panel creator or the shared user with Read/Write access. 

Share the patient panel by doing one of the following: 

• Clicking the Share ( ) button 

• Selecting File | Share 
The Panel Definition window opens to the Sharing tab of the Panel Definition 
window. 

3.2.10 Layout 
The Layout function defines which data columns to show in the current panel, the 
order of the columns chosen for display, and the initial sort order of the patients in the 
list. This layout information is stored with the panel if the user decides to save the 
panel changes. Users with read-only access can change the layout of a panel. 

Select the view layout function by doing one of the following: 

• Clicking the Layout ( ) button 

• Selecting File | Layout 
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The Patient List Layout window opens, showing the current layout for the panel. 

 
Figure 3-11: Patient List Layout dialog 

Section 14.5 provides information about using the various features on the Layout 
window. 

3.2.11 Create Register 
The Create Register function adds selected patients to the newly defined register 

Create a register by doing one of the following: 

• Clicking the Create Register ( ) button 

• Selecting Patient | Create Register 
The Create Register window opens, showing the create register form. 
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Figure 3-12: Create Register dialog 

3.2.12 Update DPCP 
The Update DPCP function updates the selected patients with the newly selected 
provider. The user is required to have either DSPM Editor (BQIZDSPM) or 
Designated Specialty Provider Management System (BDPZMENU) security key.  
The following message will be displayed if the user doesn’t have one of the above 
listed keys (see Figure 3-13). 

 
Figure 3-13: Insufficient Access Rights dialog 
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To update the DPCP, do one of the following: 

• Click the Update DPCP ( ) button 

• Select Patient | Update DPCP 
The Update DPCP dialog opens, showing the update provider form. 

 
Figure 3-14: Update Designated PCP dialog 

3.3 Patient List Tab Menu Options 
The options on the Patients menu operate like the action buttons on the toolbar. See 
section 3.2 Patient List Tab Toolbar for more information. 

3.3.1 File Menu 
The options on the File menu of the Patient List tab are as follows: 
New: This option displays the Panel Definition window where users can define a new 
patient panel. 

Modify, Share, Layout: These options work like the buttons on the toolbar. Section 
3.2 provides information on the buttons. 

Save: This option saves the changes the user made to the current Panel View 
window. 

Page Setup: This option sets the Margin, Paper, and Layout characteristics (like 
landscape or portrait orientation) for printing. 

Print: This option outputs the data in selected rows in the grid. The application 
displays the Print dialog where users select the Page Range, Number of Copies, the 
printer, etc. The application provides a header stating “Confidential Patient 
Information” for all printed panel views. 
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If no rows are selected any rows when using the Print or Print Preview option, the 
application displays a warning message: “You have not selected any rows to print. Do 
you want to proceed and print all rows in this view or cancel this print?” Click Yes to 
print all the rows. Click No to cancel the print function. 

Print Preview: This option displays the Print Preview dialog for the selected rows 
in the grid. Section 14.4 provides information about using this dialog. 

Panel Properties: This option displays the Panel Properties window. This view-
only window provides information about the panel properties. Section 2.2 provides 
information the Panel Properties window. 

Background Jobs: This option displays the Background Jobs pop-up. Section 14.8 
provides information about the pop-up. 

Close: This option closes the current Panel View window. If there are changes that 
need to be saved, the user will be notified. 

3.3.2 Tools Menu 
The options on the Tools menu are as follows: 
Quick Patient Search: This option opens the Quick Patient Search (within Panel) 
dialog. 

Mail Merge, Reset View, Refresh, Search, Excel Export, Print, Copy Rows to 
Clipboard: These options work like the buttons on the right side of the window; see 
section 14.2 for more information. 

User Preferences: This option opens the User Preferences window. 

Web Links: This option provides links to Web sites for related clinical guidelines. 
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4.0 Reminders Tab 
The Reminders tab displays reminders that are pulled from RPMS: Health Summary 
Report Reminders, EHR Clinical Reminders, HMS Reminders, CMET Reminders, 
and Immunization Forecaster Reminders. The default view is the Health Summary 
reminders. 

 
Figure 4-1: Reminders tab 

The Reminders Glossary contains information about each of the Reminders. To view 
this glossary, select Help | Reminders Glossary. 

4.1 Reminders Tab Layout 
The default view displays the fields in the following order, as described below in 
Table 4-1: 

Table 4-1: Reminders tab columns and information 

Column Information 
Flag indicator   Displays when a patient has a flag. This column is always the first column and 

can only be removed by turning all flags off in the User Preferences. 

Feather icon  The feather indicator means that there is an open CMET with an overdue 
step. Go to the CMET Tracked Events sub-tab to review this condition. 
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Column Information 
Patient Name Required field that will link to the Patient Record if by double-clicking it. 
HRN Patient’s health record number. The HRN will display as the HRN number 

followed by the facility code. 
Sex F (for female) or M (for male). 
Age Patient’s age. 
DOB Patient’s Date of Birth. 
Designated PCP Designated Primary Care Provider, if any. Not all facilities use this field to 

empanel patients. 
Community Patient’s community of residence. 
Active DX Tags One or more predefined diagnosis definitions (tags) that iCare has proposed 

for the patient that has a Proposed or Active status. 
Individual Columns There are individual columns for each kind of Reminder. 
 

View the Community alert text by hovering the mouse over the Community Alert ( ) 
icon, if any. The icon does not affect the sorting of the Community column. 

Double-click any row in the grid to access the Reminders tab of the Patient Record 
window. 

The default sort order is alphabetical by Patient Name. 

Users can sort/filter the columns and perform other functions on the columns. 

4.1.1 Due/Overdue Dates 
A date will display under each of the particular reminder’s column if the test or 
procedure is currently due. A yellow triangle icon will display if the test or procedure 
is overdue, as shown below in Figure 4-2. 

 
Figure 4-2: Overdue date for Pelvic Exam Reminder 

4.1.2 Tooltip for Reminder 
Hover the mouse over a reminder column heading to view information about it. The 
information is pulled from the Reminders application. The reminder tooltip will 
display the type of reminder by the Source and Category. 
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Figure 4-3: Reminder hover text 

4.2 Reminders Tab Toolbar 
The reminder logic is calculated and cached for display. The reminder logic is 
updated nightly by the nightly background job as well as once a week by the weekly 
job. The toolbar shows the date for which the data is effective. 

Section 14.2 provides information about the buttons on right side of window of the 
toolbar. 

4.2.1 Copy Patient(s) 
The Copy Patient function copies patient information to the iCare clipboard. 

Select one or more patients and then do one of the following: 

• Click the Copy Patient(s) ( ) button 

• Select Reminders | Copy Patient(s) 

• Press Ctrl-C on the keyboard 
Users must go to another panel view (for a different patient panel) and paste the 
patient’s information. 

4.2.2 Layout 
The Layout function determines which reminder columns to display for the current 
panel as well as the order and sorting that should be used. 

To change the layout, do one of the following: 

• Click the Layout ( ) button 
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• Select Reminders | Layout 
The Reminders Layout screen will display for the current panel. Here users can 
select the Reminders columns to display on the panel. 

 
Figure 4-4: Reminders Layout window 

There are three ways to configure the data display: Template, Customize or System 
Default. Templates can be managed in Template Management. Users with multiple 
reminder templates can choose the one appropriate for this panel. A template can be 
used over and over again for many different panels. 

 
Figure 4-5: Template Creation 

Select Customize and the configuration is only valid for this panel. System Default is 
the standard view released with iCare. 
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Update the Reminders columns by selecting Reminders and picking the appropriate 
“source” (on the Reminders Layout window) and add them to the Display 
Columns. Section14.5 provides information about manipulating the columns the 
layout. 

4.2.3 Status of Background Jobs 
To check on the status of the background jobs, do one of the following: 

• Click the Background Jobs ( ) button 

• Select File | Background Jobs 
The action accesses the RPMS iCare - Background Jobs window. Section 14.8 
provides information this window. 

4.3 Reminders Tab Menu Options 

4.3.1 File Menu 
The options on the File menu for the Reminders tab are the same as those on File 
menu for the Patient List tab. 

4.3.2 Tools Menu 
The options on the Tools menu for the Reminders tab are as follows: 
Quick Patient Search: This option opens the Quick Patient Search (within Panel) 
dialog. 

Mail Merge, Glossary, Reset View, Refresh, Search, Excel Export, Print, Copy 
Rows to Clipboard: These options work like the buttons on the right side of the 
window. 

User Preferences: This option opens the User Preferences window. 

Web Links: This option provides links to Web sites for related clinical guidelines. 
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5.0 REM Aggregated Tab 
The Reminders Aggregated tab displays the percentages and counts of patients 
within a panel that have or have not met reminder criteria. Active reminders are 
reminders that are turned on at a site. The aggregated values of Reminders will be 
calculated at the time the view is opened. 

 
Figure 5-1: Rem Aggregated tab 

5.1 Rem Aggregated Tab Layout 
The default view displays the fields on the Reminders Aggregated tab in the order as 
described in Table 5-1 below. 

Table 5-1: Reminders Aggregated tab columns and meanings 

Column Meaning 
Source The name of the source for the reminder. The following reminders 

will be organized into Source: Asthma Reminders, CMET 
Reminders, EHR Clinical Reminders, Health Summary Reminders, 
HIV/AIDS Reminders. 

Category The name of the category for the particular source. 
Reminder Name The name of the reminder. 
# Patients Eligible The total number of patients in this panel who need individual 

reminders. 
# Patients Current “Current” is defined as any due date in the future (not including 

today). 
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Column Meaning 
% Current The total percentage of patients in this panel who are current for an 

individual reminder, that is, [# Patient Current] divided by [# Patients 
Eligible]. Because of the one-month grace period for the overdue 
definition, the total percentage of Current and Overdue cannot equal 
100%. 

# Patients Overdue “Overdue” is defined as the due date equal or is before today minus 
30 days. This means the reminder is NOT counted as overdue for 
purposes of performance until at least a month. The total of the 
Patients Current and the Patients Overdue cannot equal the total 
Patients Eligible because of the one month grace period for the 
overdue definition. 

% Overdue The total percentage of patients in this panel who are overdue for an 
individual reminder. That is, [Patients Overdue] divided by [Patients 
Eligible]. Because of the one month grace period, the total 
percentage of Patients Current and Patients Overdue might not 
equal 100%. 

 
There is hover help for each cell in the Reminders Name column. 

The National Measures glossary provides information about the measures. To view 
this glossary, select Help | National Measures Glossary. 

Users can sort/filter the columns and perform other functions on the columns. 

5.2 Rem Aggregated Tab Toolbar 
The toolbar displays the date/time the data is effective. 

Section 14.2 provides information about the buttons on the right side of the toolbar. 

To check on the status of the background jobs, do one of the following: 

• Click the Background Jobs ( ) button 

• Select File | Background Jobs 
This action accesses the RPMS iCare - Background Jobs window. Section 14.8 
provides information about this window. 

5.3 Rem Aggregated Tab Menu Options 

5.3.1 File Menu 
The options on the File menu for the Reminders Aggregated tab are the same as the 
options on the File menu for the Patient List tab. 
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5.3.2 Tools Menu 
The options on the Tools menu for the REM Aggregated tab are: 

Quick Patient Search: This option opens the Quick Patient Search (within Panel) 
dialog. This is the same as pressing F8 on the keyboard. 

Glossary: This option displays the Reminders Glossary pop-up. The information 
provides Reminder descriptions (from RPMS). The pop-up has descriptions of the 
logic behind each national health summary reminder available for display in iCare. 
Users can display, print, and save the Glossary text. This is the same as clicking the 
Glossary ( ) button. 

Mail Merge, Glossary, Reset View, Refresh, Search, Excel Export, Print, Copy 
Rows to Clipboard: These options work like the buttons on the right side of the 
window. 

User Preferences: This option opens the User Preferences window. 

Web Links: This option provides links to Web sites for related clinical guidelines. 
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6.0 Natl Measures Tab 
The Natl Measures tab displays IHS national clinical performance measures as 
defined and reported in the RPMS Clinical Reporting System (CRS). iCare uses CRS 
performance logic to display whether  patients are meeting annual performance goals. 

 
Figure 6-1: National Measures tab 

6.1 What is National Performance (GPRA)? 
The Government Performance and Results Act (GPRA) requires federal agencies to 
report annually to Congress on how the agency measured up against the performance 
targets set in its annual Plan. 

Most performance measures have a denominator and a numerator defined. 

• The denominator is the total population being reviewed 

• The numerator is the number of patients from the denominator who meet the 
definition of the measure. 

Some measures are just a count, such as Sealants and Topical Fluorides. 

Measure example: GPRA Measure Cancer Screening: Pap Smear Rates: Maintain 
the proportion of female patients ages 21 through 64 without a documented history of 
hysterectomy who have had a Pap screen within the past three years at the previous 
year’s level (60.0%). 
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The denominator is the total population that is being reviewed for a specific measure. 
For the Pap smear measure, the denominator is all female patients ages 21 through 64 
at the beginning of the Report period. The numerator is the number of patients in the 
denominator who meet specific criteria. For Pap smear, the numerator is the number 
of patients in the denominator who had either a Pap smear, defined by certain codes, 
documented in RPMS any time in the three years prior to the end of the report period 
or a refusal of a Pap smear in the past year. 

If you are not familiar with your facility’s policies and practices related to national 
performance reporting, talk with your site GPRA coordinator. 

6.2 Natl Measures Tab Layout 
Users can determine which template is being used by reviewing what is in the status 
bar, in Current Layout. For example, it could read Current Layout: System Default. 

The default columns are described below in Table 6-1. 

Table 6-1: National Measures tab columns and information 

Column Information 
Flag indicator  Displays when a patient has a flag. This column is always the first column and 

can only be removed by turning all flags “off” in the User Preferences. 

Feather icon  The feather indicator in this column means that there is an open CMET with an 
overdue step. Go to the CMET Tracked Events sub-tab to review this condition. 

Patient Name Required field that will link to the Patient Record if you double-click on it. 
HRN Patient’s health record number. The HRN will display as the HRN number 

followed by the facility code. 
Sex F (for female) or M (for male). 
Age Patient’s age. 
DOB Patient’s Date of Birth. 
Designated PCP Designated Primary Care Provider, if any. Not all facilities use this field to 

empanel patients. 
Community Patient’s community of residence. 
Active DX Tags One or more predefined diagnosis definitions (“tags”) that iCare has proposed 

for the patient that has a Proposed or Active status. See section 3.1.1 
Diagnostic Tags for more information. 

Individual Columns The value of the performance met. 
 

If you double-click any record in the grid, the patient record window opens to the 
Natl Measures tab. 

Users can view the Community alert text by hovering the mouse over the Community 
Alert ( ) icon, if any. The icon does not affect the sorting of the Community 
column. 

There is hover help for each performance column that displays the GPRA definition. 
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Find information about all of the measures in the National Measures Glossary by 
selecting Help | Natl Measures Glossary. 

Users can sort/filter the columns and perform other functions on the columns. 

6.3 Natl Measures Tab Toolbar 
The toolbar shows the date/time for which the data is effective. 

Section 14.2 provides for more information about the buttons on the right side of the 
toolbar. 

6.3.1 Copy Patient(s) 
The Copy Patient(s) function copies the patient’s information to the iCare clipboard. 
This is useful for selecting patients that need additional follow-up based on the 
measure information displayed. 

Select one or more patients and then do one of the following: 

• Click the Copy Patient(s) ( ) button 

• Select National Measures | Copy Patient(s) 

• Press Ctrl-C on the keyboard 
Go to another panel view (for a different patient panel) and paste the patient’s 
information. 

6.3.2 Layout 
The Layout function determines which performance measures columns to display as 
well as the order and sorting that should be used in the current panel. 

To change the layout, do one of the following: 

• Click the Layout ( ) button 

• Select National Measures | Layout 
The Natl Measures Layout screen for the current panel will display. 
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Figure 6-2: Natl Measures Layout window 

If you choose to add the CRS Pop column (under Patient | Demographics) to the 
National Measures tab, it will display the value(s) describing the population 
category defined by CRS. The CRS Population categories include: UP (User 
Population), AC (Active Clinical), AD (Active Diabetic), etc. The population is a text 
string from the Denominator column of the CRS Patient List report that will be 
calculated for each patient within the weekly performance measures background 
process. 

Section 14.5 provides information about using the features of the layout window. 

6.3.3 Status of Background Jobs 
To check on the status of the background jobs, do one of the following: 

• Click the Background Jobs ( ) button 

• Select File | Background Jobs 
This action accesses the RPMS iCare - Background Jobs window. Section 14.8 
provides information about this window. 
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6.4 Natl Measures Tab Menu Options 
The options on the File and Tool menus for the Natl Measures tab are the same as 
those on the Patient List tab. Section 3.3 provides information about these menus. 

The options on the Natl Measures menu operate like the action buttons on the 
toolbar. Section 6.3 provides information about the buttons. 
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7.0 Natl Aggregated Tab 
The National Aggregated tab information is based on the format of the Summary 
Page from the CRS National GPRA report. It displays a summarized overview of the 
national performance measure data for patients in the panel being viewed. 

 
Figure 7-1: Natl Aggregated tab 

7.1 Natl Aggregated Tab Layout 
The following data is displayed on the Natl Aggregated tab. 

Category: The name of the category associated with the measure. 

Clinical Group: The name of the clinical performance group. 

Measure Name: The measure title derived from the Summary Report (iCare pulls 
from the first column of the CRS Summary Report). The hover help displays a description 
of the performance logic for each cell in the column. 

# Patients in Denominator: The total number of patients in this panel who meet the 
denominator definition. 

# Patients in Numerator: The total number of patients in this panel who meet the 
numerator definition. 
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% Met: The percentage of the panel who meet the measure, derived by dividing the 
denominator total by numerator total. 

year Goal: The value will be the same as the one that displays in the “GPRA” 
column on the Summary Page from the CRS National GPRA report. The “year” is the 
most recent year with final goals recorded. 

IHS Current National Performance: The value will be the same as the one that 
displays in the “Nat’l” column on the Summary Page from the CRS National GPRA 
report. 

Healthy People 2020 Goal: The value shows the 2020 goals detailed in CRS. 

Users can sort/filter the columns and perform other functions on the columns. 

7.2 Natl Aggregated Tab Toolbar 
The toolbar shows the date/time for which the data is current. 

Section 14.2 provides more information about the buttons on the right side of the 
toolbar. 

To check on the status of the background jobs, do one of the following: 

• Click the Background Jobs ( ) button 

• Select File | Background Jobs 
This action accesses the RPMS iCare - Background Jobs window. Section 14.8 
provides information about this window. 

7.3 Natl Aggregated Tab Menu Options 
The options on the File menu for the Natl Aggregated tab are the same as those on 
the File menu on the Patient List tab. 

The options on the Tools menu for the Natl Aggregated tab are the same as those on 
the Tools menu for the Reminders Aggregated tab. 
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8.0 CMET Tab 
The CMET tab on the Panel View displays data related to the Events, Tracked 
Events, and Follow-up Events for the panel of patients. 

 
Figure 8-1: Sample CMET tabs 

8.1 Events Sub-Tab 
The Events sub-tab provides data that was last retrieved on the date displayed on this 
Events window. 

 
Figure 8-2: Sample Events sub-tab 

The Events sub-tab is divided into three general areas: Tips information, Events 
toolbar, and Events data. 

The Tips information provides an overview of the Events sub-tab. You can collapse 
this area in order to have more room for viewing the Events data. 

Note: You can establish the default collapse status for the Tips 
area on this sub-tab. To do that, select Tools | User 
Preferences | CMET tab | Events sub-tab. The Tips check 
box on this sub-tab will establish the collapse status. 
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The default filters are established on the CMET tab (Events sub-tab) of user 
preferences. These filters are: Category, Status, Time Frame, and Community. 
Section 14.1.3 provides for more information about these filters. 

You can also filter the columns on the Events sub-tab. This is a temporary filter and 
will be lost once you exit the application. 

The initial Data Mining will return the most recent occurrence of every event found 
with an established timeframe. These events are displayed on the Events sub-tab. 
Section 14.1.3.5 provides for more information about the timeframes. 

8.1.1 Filters Group Box 
Use the filter features shown in the Filters group box to filter the events by using one 
or more of the following: Category, Status, Time Frame, Community, STI. Then, 
click the Get Events button to re-display the events. 

Get Events: If you change the filters in the Filters group box, click the Get Events 
button to update the display. 

Save: After you have changed the filters using the filter features in the Filters group 
box and you want these to be the default filters, click the Save button. This means 
those filters will be in effect when you use iCare in another session. This action 
changes the filters in User Preferences (on the CMET tab). 

Restore to User Pref: If you used the CMET filter features in the Filters group box 
and you want to return to the last-saved CMET filters in User Preferences, click the 
Restore to User Pref button. 

8.1.2 Events Sub-Tab Layout 
Users can determine which template is being used by reviewing what is in the status 
bar, in Current Layout. For example, it could read Current Layout: System Default. 

Table 8-1 provides information about the default columns. 

Table 8-1: Events sub-tab columns and meanings 

Column Meaning 
Category The category of the event: Breast, Cervical, Colon, Skeletal, STI. 

Patient Name Required field that will link to the Events sub-tab of the CMET tab on the Patient 
Record if you double-click on the name. 

HRN Patient’s Health Record Number. 
Sex F (for female) or M (for male) 
Age Patient’s age today. 
DOB Patient’s date of birth 
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Column Meaning 

Designated PCP Designated Primary Care Provider, if any. Not all facilities use this field to empanel 
patients. 

Community Patient’s community of residence. 

Active DX Tags Predefined Diagnosis definitions (“tags”) that iCare has proposed for this patient, 
based on the tagging function. 

Event Name Name of the event. 
Event Date The date associated with the event. 

Result The date of the result of the event. This cell also has hover help, such as V 
Radiology. 

Status The status of the event. 
Status 
Comments Text of the any comments about the status. 

Last Modified 
Date/Time The date and time the record was last modified. 

Last Modified By The name of the person who last modified the record. Initial job means it is the 
initial record. 

 
View the Community alert text by hovering the mouse over the Community Alert  
( )icon, if any. The icon does not affect the sorting of the Community column. 

Double-click the underlined Event Date to access the Visit Detail pop-up. 

Double-click the underlined Result Date to access a particular detail pop-up, for 
example, Women’s Health Detail. 

Users can sort/filter the columns and perform other functions on the columns. 

8.1.3 Events Sub-Tab Toolbar 
The toolbar shows the date/time the data is effective. 

Section 14.2 provides information about the buttons on the right side of the window. 

8.1.3.1 Copy Patient(s) 
The Copy Patient(s) function copies the patient’s information to the iCare clipboard. 

Select one or more patients and then do one of the following: 

• Click the Copy Patient(s) ( ) button 

• Select CMET | Events | Copy Patient(s) 

• Press Ctrl-C on the keyboard 
You must go to another panel view (for a different patient panel) and paste the 
patient’s information. 
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8.1.3.2 Layout 
The Layout function determines the columns on the Events sub-tab for the current 
panel. 

Select the layout function by doing one of the following: 

• Clicking the Layout ( ) button 

• Selecting File | Layout 

• Selecting CMET | Events | Layout 
This action accesses the Events Layout window. 

 
Figure 8-3: Events Layout window 

Section 14.5 provides information on using the features of the layout window. 

8.1.3.3 Track 
The Track function requires the iCare Editor (BQIZCMED) security key. Select one 
or more events with a status of Not Tracked or Pending and then click the Track 
button (or select Track on the context menu). 
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Once an event has been Tracked, it cannot be changed to Not Tracked. If the 
particular event was changed to Tracked incorrectly, go to the Tracked tab. Next, 
access the CMET worksheet for the event you tracked in error. 

If you select events that are not eligible for the Tracked function, the application 
displays the message: “Events having a status of Tracked can’t be changed to 
Tracked.” Click OK to dismiss the message. 

If you select only one eligible event, the application displays the RPMS iCare - 
Track - Findings Due Date dialog. 

 
Figure 8-4: RPMS iCare - Track - Findings Due Date dialog 

If you selected more than one eligible event, the application displays the RPMS 
iCare - Track - Findings Due Date dialog (for multiple events). 

 
Figure 8-5: RPMS iCare - Track - Findings Due Date dialog for multiple events 

In either case, do the following: 

• Make sure that the correct date is in the Findings Due Date field (required). 
Change it by clicking the list to access a calendar (where you can select another 
date). The date cannot be earlier than the current date. 

• Type the text of the reason for changing the status to TRACKED in the Free Text 
field (not required). 



iCare Population Management GUI (BQI) Version 2.6 

Panel View User Manual CMET Tab 
July 2017 

40 

• Click Save to save the information. (Otherwise, click Cancel). Saving the 
information changes the status of the events to Tracked. These events will display 
on the Tracked Events sub-tab of the main window as well as on the Tracked 
Events sub-tab of the Patient Record window. 

If you use the Save and Enter Findings button for a single event, the application 
displays the CMET Worksheet (where you can add Findings to the event, for 
example). Section 14.9 provides for more information about the worksheet. After 
saving the worksheet, you return to the Events sub-tab. 

8.1.3.4 Don’t Track 
Use the Don’t Track button to change the status of a Pending event to Not Tracked. 
Select the events and click Don’t Track (or select Don’t Track on the context menu). 

Tracked events are not eligible for the Not Tracked function. Selecting Tracked 
events in this function results in the application displaying the message: “Once an 
event has been Tracked, it cannot be changed to Not Tracked. See the User Manual 
guidance on how to manage an event that was tracked.” Click OK to dismiss the 
message.  

If the selected Tracked event was erroneously tracked in error, section 14.13 provides 
for more information about how to handle this error. 

After selecting eligible events, the application displays the RPMS iCare – Don’t 
Track Event dialog. 

 
Figure 8-6: Sample RPMS iCare – Don’t Track Event dialog 

Type a reason for the change in the Free Text field (not required). Click OK to save 
and change the Status of the events to Don’t Track. (Otherwise, click Cancel.) 

8.1.3.5 Pend 
Click the Pend button to change the status of Not Tracked event to Pending. Select 
the events and then click the Pend button (or select Pend on the context menu). 

If you select events that are not eligible for the Pend function, the application 
displays the message: Only events with status of Not Tracked can change to Pending. 
Click OK to dismiss the message. 
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Figure 8-7: Pend Function Message 

If you selected eligible events, the application displays the RPMS iCare – Pend 
Event dialog. 

 
Figure 8-8: RPMS iCare – Pend Event dialog 

Type a reason for the change in the Free Text field (not required). Click OK to save 
and change the Status of the events to Pending. (Otherwise, click Cancel.) 

8.1.3.6 Add Manual Event 
Use Add Manual Event function to add manual events. 

The Add Manual Event function requires the iCare Editor (BQIZCMED) or iCare 
Package Manager (BQIZMGR) security key. 

Add a new manual event by doing one of the following: 

• Clicking the Add Manual Event ( ) button 

• Selecting CMET | Events | Add Manual Event 
The Select Patients window opens. 
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Figure 8-9: Selected Patients dialog 

The Add Manual Event window opens. 

 
Figure 8-10: Add Manual Event dialog 
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The fields with the asterisk (*) following the name are required. 

Date: Select a date for the event. 

Event: Select the event. 

PCC File: Select the PCC File. 

Default Value: Select a default value for the event. 

Finding: Select a finding, if desired for the event. 

Select Location:  

IHS/Tribal Facility: Select a Location  
or 
Other: Enter Outside Location and if desired, Outside Provider 

Findings Comment: Enter a comment for the finding, if desired. 

Use Save to save a new manual event. 

Use Save and Track to save a new manual event and track, which has the same 
behavior as the Track button (Section 8.1.3.3). 

Use Save, Track and Open WorkSheet to save a new manual event, track and open 
CMET worksheet.  Same behavior as the Open CMET Worksheet button (Section 
8.2.2.6) on Tracked Events tab. 

8.1.3.7 Batch Process 
The Batch Process only applies to screening mammograms and Pap smears with 
normal results. This process can be applied to multiple events. Although it can be 
applied to one event, its purpose is to be applied to multiple events. 

The CMET Package Manager sets the parameters for batch processing for the entire 
site. The Batch Process function requires the iCare Editor (BQIZCMED) security 
key. 

The Batch Process works only on events that are Pending. Otherwise, the application 
will display an error message. 

Select either the mammogram screening events or the Pap smear events to batch 
process. Then, click the Batch Process button (or select Batch Process on the 
context menu) to batch process the selected events and to change the Status/State to 
Closed. (The selected events must be of the same type of event, either all 
mammogram screenings or all Pap smears.) 
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• If selecting mammogram screening events that are eligible for this process, the 
application displays the CMET Batch Mammogram Screening dialog. Section 
14.10 provides for more information about this dialog. 

• If selecteding Pap smear events that are eligible for this process, the application 
displays the CMET Batch Pap Smear dialog. Section 14.11 provides for more 
information this dialog. 

8.1.3.8 Status of Background Jobs 
Click the Status of Background Jobs ( ) button to check the status of the 
background jobs; this displays the RPMS iCare - Background Jobs window. 
Section 14.8 provides information about this window. 

8.2 Tracked Events Sub-Tab 
The CMET events that are identified as “Tracked” for the current panel will display 
on the Tracked Events sub-tab. 

 
Figure 8-11: Tracked Events sub-tab 

The Tracked Events sub-tab is divided into three general areas: Tips information, 
Tracked Events toolbar, and Tracked Events data. 

The Tips information provides an overview of the Tracked Events sub-tab. Users can 
collapse this area in order to have more room for viewing the Tracked Events data. 
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8.2.1 Tracked Events Sub-Tab Layout 
You can sort/filter the columns and perform other functions on the columns 

You can determine which template is being used by reviewing what is in the status 
bar, in Current Layout. For example, it could read Current Layout: System Default. 

Table 8-2 below provides information about the columns. 

Table 8-2: Tracked Events sub-tab columns and meanings 

Column Meaning 
Category The category of the tracked event: Breast, Cervical, Colon. Skeletal, STI. 
Patient Name Required field that will link to the Tracked Events sub-tab of the CMET tab on the 

Patient Record if you double-click on it. 
HRN Patient’s Health Record Number. 
Sex F (for female) or M (for male) 
Age Patient’s age today. 
DOB Patient’s date of birth. 
Designated PCP Designated Primary Care Provider, if any. Not all facilities use this field to 

empanel patients. 
Community Patient’s community of residence. 
Active DX Tags Predefined Diagnosis definitions (“tags”) that iCare has proposed for this patient, 

based on the tagging function. 
1 - Event Name of the event. 
Event Date The date associated with the event. 
Preceding Event Contains the date of the preceding event. Double-click on this underlined date to 

open the Tracked Events of the CMET tab on the Patient Record. The chain of 
events in the same category is revealed. In addition, there is hover help when 
you move your mouse over the date (for example, PAP SMEAR 139). 

Results The date of the result of the event. Hover help will describe where the result 
came from (V-RADIOLOGY, V-LAB). 

2 - Finding(s) The icons indicate if the event has any findings. 
Interpretation The interpretation of the Finding. 
3 - Follow-up(s) The icon indicates if the event has follow-up data. 
4 - Patient 
Notification(s) 

The icon indicates if the event has any patient notification data. 

State The state of the tracked event (Open or Closed). 
 

When the 2 - Finding(s) cell contains the following: 

• The feather ( ) icon indicates that the element is overdue; hover your mouse 
over the icon to view the Due Date (the tickler). 

• The check( ) icon indicates that the step is complete; hover your mouse of the 
icon to view the Finding Due date and the Finding Value. 

• Blank indicates that the element is not complete but is not overdue. 
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When the 3 - Follow-up(s) cell contains the check ( ) icon, this means the step is 
complete; hover your mouse of the icon to view the Follow-up Date and the Follow-
up type. If it is blank, this indicates that element is not complete but is not overdue. 

When the 4 - Patient Notification(s) cell contains the check ( ) icon, this means 
the step is complete; hover your mouse of the icon to view the Notification Date and 
the Notification method. If it is blank, this indicates that element is not complete but 
is not overdue. 

The Results column will display the date (Linked) if results have been mined during 
the nightly job. The data link will be the most recent result. Hover help will describe 
where the result came from, for example, v-lab. 

8.2.2 Tracked Events Sub-Tab Toolbar 
The toolbar shows the date/time for which the data is effective. 

Section 14.2 provides more information about the buttons on the right side of the 
window operate. 

8.2.2.1 Copy Patient(s) 
The Copy Patient(s) button works like the one on the Events sub-tab. Section 8.1.3.1 
provides information about this button. 

8.2.2.2 Layout 
Use the Layout function to determine the columns on the Tracked Events sub-tab 
for the current panel. 

Select the layout function by doing one of the following: 

• Clicking the Layout ( ) button 

• Selecting File | Layout 

• Selecting CMET | Tracked Events | Layout 
This action accesses the Tracked Events Layout window. 
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Figure 8-12: Tracked Events Layout window 

Section 14.5 provides information about using the features of the layout window. 

8.2.2.3 Reopen 
Use the Reopen function to change a Closed event to Open. Select only one event 
having a State of Closed and then click the Reopen button (or select Reopen on the 
context menu). The application displays the RPMS iCare – Reopen Tracked Event 
dialog. 

 
Figure 8-13: RPMS iCare – Reopen Tracked Event dialog 

Type the reason for changing the state back to Open in the Free Text field (not 
required). When the dialog is complete, click OK to change the State for the event to 
Open. (Otherwise, click Cancel.) 
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If you select more than one event and use the Reopen function, the application 
displays the warning message: “Please reselect as only one event can be reopened at 
one time.” Click OK to close the warning message and select only one event. 

8.2.2.4 Close 
Use the Close function to change an Open event to Closed. Select the events with a 
State of Open and then click the Close button (or select Close on the context menu). 
The application displays RPMS iCare – Reason for Closing dialog. 

 
Figure 8-14: RPMS iCare – Reason for Closing dialog 

The fields with the asterisk (*) following the name are required. 

Reason: Select an option from the drop-down list: Event Complete, Patient Moved, 
Lost to Follow-up, Other (this option requires a comment). 

Comment: This Free Text field is required when the Reason = Other. Type the text of 
the reason. 

When the dialog is complete, click OK to change the State for the selected events to 
Close. (Otherwise, click Cancel.) 

8.2.2.5 Batch Process 
The Batch Process works like the Batch Process on the Events sub-tab. Section 
8.1.3.6 provides information about the batch process. 

8.2.2.6 Open CMET Worksheet 
Select an event and then click the Open CMET Worksheet button (or select Open 
CMET Worksheet on the context menu) to access the CMET Worksheet (for the 
event). Here you can enter Finding(s), Follow-up(s), and Patient Notification(s) for 
the event. Section 14.9 provides for more information about the worksheet.  
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Note: This function can be applied to only one event. 

8.2.2.7 Status of Background Jobs. 
To check on the status of the background jobs, do one of the following: 

• Click the Background Jobs ( ) button 

• Select File | Background Jobs 
This displays the RPMS iCare - Background Jobs window. Section 14.8 provides 
information about this window. 

8.3 Follow-up Events Sub-Tab 
The Follow-up Events sub-tab contains what you want to do for follow-up. The 
follow-up events are generated by the recommendation(s) made for the follow-up of 
the Tracked CMET event. 

 
Figure 8-15: Follow-up Events sub-tab 

The Follow-up Event Name and Date are pulled from step three of the CMET 
process. This is the provider’s recommendation for follow-up. The date is the date 
due for the follow-up. 

A CMET Reminder is also generated by the same recommendation(s). Group Order 
might be disabled by your Site Manager or your site might not support Mammogram 
Screenings. 
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The Follow-up Events sub-tab is divided into three general areas: Tips information, 
Follow-up Events toolbar, and Follow-up Events data. 

The Tips information provides an overview of the Follow-up Events sub-tab. You can 
collapse this area in order to have more room for viewing the Follow-up Events data. 

8.3.1 Follow-up Events Sub-Tab Layout 
The data on the Follow-up Events sub-tab is effective as of the date on the window. 

Users can determine which template is being used by reviewing the status bar, in 
Current Layout. For example, it could read Current Layout: System Default. 

Table 8-3 below provides information about the columns. 

Table 8-3: Follow-up Events sub-tab columns and meanings 

Column Meaning 
Category The category for the Follow-up Event: Breast, Cervical, Colon, Skeletal. 
Follow-up Event 
Name 

The name of the event. 

Follow-up Event 
Date 

The follow-up date for the event. 

Preceding Event Contains the date of the preceding event. Double-click on this underlined date to 
open the Follow-up Events of the CMET tab on the Patient Record. The chain of 
events in the same category is revealed. 

Patient Name Required field that will link to the Follow-up Events sub-tab of the CMET tab on the 
Patient Record if you double-click the name. 

HRN Patient’s Health Record Number. 
Sex F (for female) or M (for male) 
Age Patient’s age today. 
DOB Patient’s date of birth (required) 
Designated PCP Designated Primary Care Provider, if any. Not all facilities use this field to empanel 

patients. 
Community Patient’s community of residence. 
Active DX Tags Predefined Diagnosis definitions (“tags”) that iCare has proposed for this patient, 

based on the tagging function. 
 

View the Community alert text by hovering the mouse over the Community Alert ( ) 
icon, if any. The icon does not affect the sorting of the Community column. 

8.3.2 Follow-up Events Sub-Tab Toolbar 

8.3.2.1 Copy Patient(s) 
The Copy Patient(s) button works like the one on the Events sub-tab. Section 8.1.3.1 
provides information about this button. 
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8.3.2.2 Layout 
Use the Layout function to determine the columns on the Follow-up Events sub-tab 
for the current panel. 

Select the layout function by doing one of the following: 

• Clicking the Layout ( ) button 

• Selecting File | Layout 

• Selecting CMET | Follow-up Events | Layout 
This action accesses the Follow-up Events Layout window. 

 
Figure 8-16: Follow-up Events Layout window 

Section 14.5 provides information about using the features of the layout window. 

8.3.2.3 Open CMET Worksheet 
Select an event and then click the Open CMET Worksheet button (or select Open 
CMET Worksheet on the context menu) to access the CMET Worksheet for the 
event. Here you can enter Finding(s), Follow-up(s), and Patient Notification(s) for the 
event. Section 14.9 provides for information about the worksheet.  
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Note:  This function can be applied to only one event. 

8.3.2.4 Status of Background Jobs. 
To check on the status of the background jobs, do one of the following: 

• Click the Background Jobs ( ) button 

• Select File | Background Jobs 
This displays the RPMS iCare - Background Jobs window. Section 14.8 provides 
information about this window. 

8.4 CMET Tab Menu Options 

8.4.1 File Menu 
The options on the File menu for the CMET tab are similar to those on the File menu 
for the Patient List tab. 

8.4.2 Tools Menu 
The options on the Tools menu for the CMET tab are the same as the options on the 
Tools menu for the Patient List tab. 

8.4.3 CMET Menu 
The options on the CMET menu operate like the action buttons on the various sub-
tabs. 
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9.0 Care Mgmt Tab 
The Care Mgmt tab displays data related to various groups of the patients in the 
panel. 

 
Figure 9-1: Care Mgmt tab 

This tab displays information from the register (shown in the “Please Select a Group 
field”) for the patients in the panel. Select an option for this field in order to view the 
data. 

 
Figure 9-2: Various groups for the Care Mgmt tab 

iCare provides you with existing Register capabilities for iCare panels for specific 
underlying case management applications. 

The underlying RPMS application for the HIV/AIDS Register option is BKM. 
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9.1 User Preferences for Panel View 
Access User Preferences for Panel View by selecting Tools | User Preferences. 

Users can establish the tab and panel to display when opening the Panel View on the 
Panel View window. 

Users can establish Panel View as the startup view when opening iCare on the 
Startup View tab. 

Section 14.1 provides more information about using the User Preferences for the 
Panel View window. 

9.2 Main Sub-Tab 
The Main sub-tab displays register information about the patients in the particular 
panel. 

 
Figure 9-3: Main sub-tab view for HIV/AIDS register 

Note: Only the Main sub-tab displays for Asthma, COPD, 
Diabetes, DM Audit, Employee Health, Hep C, 
Immunizations, Pediatric, and Prenatal groups. 

9.2.1 Main Sub-Tab Layout 
Table 9-1 provides information about the default columns for the COPD, Diabetes, 
DM Audit, Employee Health, Hep C, HIV/AIDS, Immunizations, Pediatric, and 
Prenatal groups. 
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Table 9-1: Main sub-tab columns and meanings 

Column Meaning 
Flag Indicator  Displays when a patient has a flag. This column is always the first column 

and can only be removed by turning all flags “off” in the User 
Preferences. 

Feather icon  The feather indicator in this column means that there is an open CMET 
with an overdue step. Go to the CMET Tracked Events sub-tab to review 
this condition. 

Patient Name Required field that will link to the Patient Record if you double-click the 
name. 

HRN Patient’s Health Record Number. 
Sex F (for female) or M (for male). 
DOB Patient’s date of birth. 
Designated PCP Designated Primary Care Provider, if any. Not all facilities use this field to 

empanel patients. 
Community Patient’s community of residence. 
Active DX Tags Predefined Diagnosis definitions (“tags”) that iCare has proposed for this 

patient, based on the tagging function. 
Register Status (only for 
HIV/AIDS) 

The status of this patient on the HMS Register. Values are can Active, 
Deceased, Inactive, or Transient. 

Remaining Columns The register-specific data. 
 

Users can sort/filter the columns and perform other column functions. 

There is hover help for the columns displaying register-specific data. For example, 
view the help by hovering the mouse over the HIV Provider column heading. 

View the Community alert text by hovering the mouse over the Community Alert ( ) 
icon, if any. The icon does not affect the sorting of the Community column. 

The Community Alerts glossary provides a list of diseases that occur in mandatory 
alerts. To view this glossary, select Help | Community Alerts Glossary (on the main 
iCare window). 

9.2.2 Main Sub-Tab Toolbar 
Section 14.2 provides information about the buttons on the right side of the toolbar. 

9.2.2.1 Copy Patient(s) 
The Copy Patient(s) function copies the patient’s information to the iCare clipboard. 

Select one or more patients and then do one of the following: 

• Click the Copy Patient(s) ( ) button 

• Select Care Mgmt | Main | Copy Patient(s) 

• Press Ctrl-C on the keyboard 
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Go to another panel view (for a different patient panel) and paste the patient’s 
information. 

9.2.2.2 Layout 
Click the Layout button (or select Care Mgmt | Main | Layout) to display the 
panel’s layout of the columns. 

Section 14.5 provides information about using the features of the layout window. 

9.2.2.3 Change Status 

Note: The Change Status buttons do not apply to Employee 
Health, Hep C, Immunizations, and Pediatric groups. 

Use the Accept, Not Accept, and Proposed buttons to change the Status on an existing 
record (or select Care Mgmt | Main to select a status to change). 

To change the status on a patient record, select the record and click the appropriate 
Change Status button to display the Update Diagnostic Tag dialog. 

 
Figure 9-4: Update Diagnostic Tag dialog 

All fields are required on this dialog. 

The option buttons available for the Status Change Reason changes according to the 
selection in the New Status field. 
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The Not Accept function cannot be performed on multiple patients or multiple tags. 

Section 10.2.3 provides information about the fields and View Tag Activity button 
on this dialog. 

9.2.2.4 Add Tag 

Note: The Add Tag button does not apply to Employee Health, 
Hep C, Immunizations, and Pediatric groups. 

To add a tag to a patient record, select that patient and click the Add Tag ( ) 
button (or select Care Mgmt | Main | Add Tag) to display the Add Diagnostic Tag 
dialog. This is a manual add that allows a provider to manually assign one or more of 
the diagnosis tags to patients that did not meet the tag’s criteria for being proposed 
automatically. Section 10.2.3 provides information about using the Add Tag button. 

9.2.2.5 Update 

Note: The Update button applies to the HIV/AIDS group only. 

Users can batch update register data for selected patients. Click the Update ( ) 
button (or select Care Mgmt | Main | Update). The Batch Update Data dialog will 
display. 

 
Figure 9-5: Batch Update Data dialog 

After choosing an option from the Select drop-down list, a second field displays. 
When the second field has an ellipsis button, click it to search for the name on a 
lookup dialog. 

Click OK to save the information. (Otherwise, click Cancel). After the update is 
complete, the following message displays: “HIV Register data has been saved 
successfully to RPMS.” Click OK to dismiss this message. After clicking OK, 
refresh the screen to view the changes. 
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9.2.2.6 Reports Button 

Note: The Reports button applies to the HIV/AIDS group only. 

Select one or more patients and click the list on the Reports  button to view the 
Quality of Care report (or select Care Mgmt | Main | Reports).The reports define 
their scope based on the patients that are members of a given panel. 

If any taxonomy does not have any entries, the application displays the iCare 
Taxonomy Report Check information message that lists the taxonomies that do not 
have any entries. The bottom of the message states: The HIV Management System 
Quality of Care uses these taxonomies when generating the report. Use the option 
Tools | Taxonomy Maintenance from the iCare main menu to view and edit these 
lists. Click OK to continue and generate the report. Section 14.6 provides information 
about the taxonomy maintenance process. 

 
Figure 9-6: Quality of Care Report Parameters dialog 

If you selected more than one patient on the panel, the Report Population field will 
display “Selected Patient(s) (n selected)” where n is the number of patients selected. 

Populate the fields on the Quality of Care dialog by selecting any option on the list. 
Then, click OK to output the report. (Otherwise, click Cancel.) 

Note:  If the report cannot be run, for example when the selected 
patients for the report did not meet the criteria, the 
application displays message about this condition. Click 
OK to dismiss the message. 

iCare provides the ability to display, print, and export the existing BKM Quality of 
Care Report from the Panel Register view. 

This report includes all patients who have at least one HIV/AIDS POV, Active 
Problem List, HMS Initial HIV Dx Date, or HMS Initial AIDS Dx Date at least 182 
days (six months) prior to Report End Date. 
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Below is an example of the first part of the report: 

 
Figure 9-7: Sample Report, Page 1 

The following shows a page of the report, near the end, which describes the criteria of 
the selected denominator for the report. 
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Figure 9-8: Quality of Care Report – criteria of selected denominator 

The final page of the report displays all of the patients in the selected denominator 
(those patients on the report). 

Section 14.7 provides information about using the controls on the pop-up. 

9.3 Reminders Sub-Tab for HIV/AIDS Register 
The Reminders sub-tab view displays the disease/register-specific reminders for the 
patient. 
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Figure 9-9: Reminders sub-tab 

The Reminders sub-tab displays ONLY for the HIV/AIDS register. 

9.3.1 Reminders Sub-Tab for HIV/AIDS Register Layout 
Below, Table 9-2 shows the default fields on the Reminders sub-tab for the 
HIV/AIDS Register: 

Table 9-2: Reminders sub-tab columns and meanings 

Column Meaning 
Flag indicator  Displays when a patient has a flag. This column is always the 

first column and can only be removed by turning all flags “off” 
in the User Preferences. 

Feather icon  The feather indicator in this column means that there is an 
open CMET with an overdue step. Go to the CMET Tracked 
Events sub-tab to review this condition. 

Patient Name Required field that will link to the Patient Record if you 
double-click on it. 

HRN Patient’s Health Record Number. 
DOB Patient’s date of birth. 
Remaining Columns The reminders for the HIV/AIDS register-specific data. 

 
A date (or N/A) will display under each of the Reminders columns. An icon will 
display if the test or procedure is overdue, as shown below. 

 
Figure 9-10: Sample Overdue Date for Chlamydia Reminder 
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9.3.2 Reminders Sub-Tab for HIV/AIDS Register Toolbar Options 
The toolbar shows the date/time for which the data is effective. 

Display a tooltip for a reminder by hovering the mouse over the column heading. 

Click the Copy Patient(s)  button, or select Care Mgmt | Main | Copy 
Patient(s), to copy the selected patients information to the iCare clipboard. Go to 
another panel view (for a different patient panel) and paste the patient information. 

Users can sort/filter the columns and perform other column functions. 

Section 14.2 provides information about the buttons on the right side of the toolbar. 

9.4 Care Mgmt Tab Menus 
The options on the File menu for the Care Management tab are the same as those on 
the Patient List tab. Section 3.3.1 provides information about the File menu options. 

The options on the Tools menu for the Care Management tab are the same as those 
on the Reminders tab. Section 4.3.2provides information about the Tools menu. 

The options on the Care Mgmt menu vary according to if you are on the Main or 
Reminders sub-tab. The options on each are the same as the action buttons on the 
toolbar. 
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10.0 Diagnostic Tags Tab 
The Diagnostic Tags tab provides a comprehensive view of all tag history for a 
patient (regardless of the tag status), provides auto-accept and auto-reject capabilities, 
allows the user to accept a proposed tags for multiple patients, allows the user to 
reject proposed tags, and allows the user to update of tag status. 

 
Figure 10-1: Diagnostic Tags tab 

Tags that are identified through iCare’s execution of the pre-defined tag criteria will 
start with an initial tag status of PROPOSED. From there, users have several options 
including “Accepting” a tag or “Not Accepting” a tag for any patient. These statuses 
are editable from within this tab. 

10.1 Diagnostic Tags Tab Layout 
Table 10-1 provides information about the columns. 

Table 10-1: Diagnostic Tags tab columns and meanings 

Column Meaning 
Patient Name Required field that will link to the Patient Record if you double-

click the name. 
HRN Patient’s Health Record Number. 
DOB Patient’s Date of Birth. 
Age Patient’s age. 
Tag Name The name of the tag for the patient. 
Status ACCEPTED: The patient is a member of specified formal case 

management registers with a status of Active, Decease, 
Transient, Non IHS, Lost to Follow Up, or Noncompliant. 
PROPOSED: The patient has Status Unreviewed or Inactive in 
the register. 
NO LONGER VALID: The RPMS data no longer supports the 
tag. 

Status Change Reason The reason the status changed. Options include: System 
Generated (system), RPMS Data No Longer Supports Tab 
(system), Patient Data Does Not Support Acceptance (user), 
Manually Designated (user), Other (user - with required 
comment field), or Existing RPMS Register (system). 

Status Comment The text of any comments entered about the status change 
(used with the Other status change reason). 
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Column Meaning 
Last Updated The date the content of the panel was last updated by a manual 

(user) repopulate, by an auto-repopulate, or the panel created 
date, if the panel has never been repopulated. 

Last Updated By The name of the user who either created or last repopulated 
the panel (in certain cases, it will contain SYSTEM UPDATE). 

 
There is hover help for the Tag Name cell that shows the name of the tag. 

Double-click any record to go the Diagnostic Tags tab of the Patient Record 
window. 

Users can find information on all tags in the Diagnostic Tag Glossary (select Help | 
Diagnostic Tag Glossary). 

Users can sort/filter the columns and perform other functions on the columns. 

10.2 Diagnostic Tags Toolbar 
The toolbar shows the date/time for which the data is effective. 

iCare will classify tags into one of five statuses: Proposed (pending) (P), Accepted 
(A), Not Accepted (NA), No Longer Valid (NLV) and Superseded (S). Tags with a 
classification of NA will not display. 

Section 14.2 provides information on the buttons on the right side of the toolbar. 

10.2.1 Copy Patient(s) 
The Copy Patient(s) funtion copies the patient’s information to the clipboard. 

Select one or more patients and then do one of the following: 

• Click the Copy Patient(s) ( ) button 

• Select Diagnostic Tags | Copy Patient(s) 

• Press Ctrl-C on the keyboard 
Go to another panel view (for a different patient panel) and paste the patient 
information. 

10.2.2 Change Status 
Use the Accept, Not Accept, and Proposed buttons to change the Status on an existing 
record (or select Care Mgmt | Main to select a status to change). Section 9.2.2.3 
provides information about using these buttons. 
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10.2.3 Add Tag 

Select a patient to whom you want to add a tag and click the Add Tag ( ) button 
(or select Diagnostic Tags | Add Tag) to display the Add Diagnostic Tag dialog. 
This is a manual add that allows a provider to manually assign one or more of the 
diagnosis tags to patients that did not meet the tag’s criteria for being proposed 
automatically. 

  
Figure 10-2: Add Diagnostic Tag dialog 

This dialog shows information about the patient named in the Patient Name field 
(the one selected). 

After completing the dialog, click OK to add the information to the Diagnostic Tags 
tab on the Panel View. (Otherwise, click Cancel.) 

10.2.3.1 Tag Activity 
Users can view existing tag activity for a patient by clicking the View Tag Activity 
button. The Diagnostic Tag Activity pop-up displays. Section 10.2.4 provides more 
information about this pop-up. 

10.2.3.2 Fields on Add Diagnosis Tag Dialog 
All fields are required. 
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Patient Name: The name of the patient to whom to add tag information (application 
populated). 

Diagnostic Tag: The name of diagnostic tag to add for the patient. Select an option 
from the list to populate this field. 

New Status: The status of the tag being added. 

ACCEPTED: This option allows users to “Accept” a proposed tag to provide an 
affirmation of its validity for a given patient. 
NOT ACCEPT: This option allows users to disapprove or “Not Accept” a 
diagnostic tag that has been proposed for a patient. 
PROPOSED: This option allows users to change the status of a diagnosis tag back 
to “Proposed” so that further review can take place. 

Reason: Click the appropriate reason for adding the tag. 

• Patient Data Supports Acceptance - Use this when the patient data supports 
the tag. 

• Manually Designated - Use this when you want to manually change the tag 
status. 

• Other - Use this when the other reasons do not fit. 
Status Comment: Type the reason for the change in this Free Text field. This feature 
provides a rich audit history for reasons for providers’ decisions to accept or not 
accept proposed tag assignments. 

10.2.4 Activity 

View existing tag activity for the selected patient by clicking the Activity ( ) 
button on the Panel View toolbar (or by selecting Diagnostic Tags | Activity). The 
RPMS iCare - Diagnostic Tag Activity pop-up displays. This is a view-only pop-up. 
Multiple users can enter tags, so this pop-up shows all of the activity. 

  
Figure 10-3: Diagnostic Tag Activity pop-up 

Section 14.2 provides information on the buttons on the right side of the toolbar. 

Click the Glossary ( ) button to display the Diagnostic Tag Glossary.  
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Users can sort/filter the columns and perform other functions on the columns. 

Users can view various tags by selecting from the list for the Tag field. 

If you check the Display Factor Details check box, the following columns will 
display: Factor, Date, Item, Value. This allows you to view additional details about 
the tags. The default view is unchecked. You must dismiss the pop-up. 

10.2.5 Status of Background Jobs 
To check on the status of the background jobs, do one of the following: 

• Click the Background Jobs ( ) button 

• Select File | Background Jobs 
This action accesses the RPMS iCare - Background Jobs window. Section 14.8 
provides information this window. 

10.3 Diagnostic Tags Tab Menu Options 
The options on the File menu for the Diagnostic Tags tab are the same as those on 
the File menu for the Patient List tab. 

The options on the Tools menu for the Diagnostic Tags tab are the same as those on 
the Tools menu for the Reminders tab. 

The Diagnostic Tags menu has options that operate like the action buttons on the 
toolbar. Section 10.2 provides more information on the buttons. 
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11.0 Flags Tab 
The Flags tab of the Panel View displays the flags for the patients in the open panel. 

 
Figure 11-1: Flags tab 

The Flags tab displays the flag type shown in the Show field. 

Users can change the default flag display by changing the flag settings under User 
Preferences. 

Double-click any record on this tab to go to the Flags tab of the Patient Record 
window. 

11.1 Flags Tab Layout 
The default display has the flags listed alphabetically by flag date (most recent first), 
by patient name, and then by flag type. No duplicate values are displayed in the first 
column. This means if a particular date has more than one flag, the date will be 
displayed only on the first row. 

The iCare application will display an initial list of flags at first login only for the 
timeframe that is defined in the User Preferences. Likewise, you can change the flag 
view to display modified flag types and/or timeframes if you change the User 
Preferences. After changing the flag settings in User Preferences, refresh the flag 
view. 

Users can sort/filter the columns and perform other functions on the columns. 

Table 11-1 provides information about the columns. 

Table 11-1: Flags tab columns and meanings 

Column Meaning 
Flag Date The date the flag became active, e.g., the date of the hospital 

admission. 
Patient Name This is a required field and will link to the patient’s Patient Record if 

you double-click the name. 
HRN Patient’s Health Record Number. 
Sex Either F (for Female) or M (for Male) 
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Column Meaning 
Age Patient’s age. 
DOB Patient’s Date of Birth. 
Flag Type This can be Abnormal Lab Values, ER Visit, Unanticipated ER 

Return Visit, Hospital Visit. 
Flag Description A brief description of the event that caused the trigger. 
Designated PCP Designated Primary Care Provider, if any. Not all facilities use this 

field to empanel patients. 
 

The Flag Type column contains various flag types, as defined in Table 11-2 below. 

Table 11-2: Flag types and meanings 

Flag Type Meaning 
Abnormal Lab Values 
Alert 

This flag type informs the user when a patient has abnormal lab 
values within a user-defined timeframe, based on the Kernel 
Alerts component. The Abnormal Lab Values alerts, generated 
from the RPMS Laboratory application, reside in the Kernel Alerts 
component. If the ALV alert is closed by the provider in Kernel 
Alerts, it will no longer display in iCare, regardless of the Flag 
Display Timeframe selected by the user in the User Preferences. 

ER Visit This flag type informs the user when a patient has an emergency 
room visit within a user-defined timeframe. This flag is generated 
directly by iCare. ER visits (clinic code 30) is the trigger for this 
flag. 

Unanticipated ER 
Return Visit 

This flag type informs the user when a patient has an emergency 
room visit designated as “unanticipated” within a user-defined 
timeframe. This flag is generated directly by iCare. ER visits 
(clinic code 30) with Visit Type “Unscheduled Revisit” is the 
trigger for this flag. 

Hospital Admission This flag type informs the user when a patient has a hospital visit 
within a user-defined timeframe. This flag is generated directly by 
iCare. Any visit with service category H where the discharge date 
is not the same day as the admission date is the trigger for this 
flag. 

 

11.1.1 Flags Tab Toolbar 
The text above the grid shows the flag set-up information and how current the data is. 

11.1.1.1 Show Field 
Which flags are displayed on this window is determined by the option selected on the 
Show field. The choices are listed below: 

• Active Flags: Active is defined as a flag that has not expired and has not been 
hidden by the users. 

• Hidden Flags: Those flags that you specified to be hidden, using the Hide button. 

• All Flags: All flags—hidden as well as active. 



iCare Population Management GUI (BQI) Version 2.6 

Panel View User Manual Flags Tab 
July 2017 

70 

11.1.1.2 Hide 
Users can hide a highlighted row in the Flag List grid by doing any of the following: 

• Clicking the Hide ( ) button 

• Selecting File | Flags | Hide 

• Selecting the Hide option on the context menu 

• Pressing F3 on the keyboard 
View hidden flags by selecting the Hidden Flags option on the Show field. 

11.1.1.3 Show 
To display a hidden flag in the current view, select it from the list on the Hidden 
Flags option (from Show field) and do any of the following: 

• Click the Show ( ) button 

• Select File | Flags | Show 

• Select the Show option on the context menu 

• Press F4 on the keyboard 

11.1.1.4 Status of Background Jobs 
To check on the status of the background jobs, do one of the following: 

• Click the Background Jobs ( ) button 

• Select File | Background Jobs 
This action accesses the RPMS iCare - Background Jobs window. Section 14.8 
provides information this window. 

11.1.2 Flags Tab Menu Options 
The options on File and Tools menus are the same those on the Patient List tab. 
Section 3.3 provides more information about these menus. 

The Flags menu is only available when the Flags tab is selected. The Hide and Show 
options work like the Hide and Show action buttons. The Refresh option refreshes 
the flags display, to show the most recent changes. 
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12.0 Referrals Tab 
The Referrals tab displays referral data for the panel of patients. 

 
Figure 12-1: Referrals tab 

12.1 Referrals Tab Layout 
The default view displays the fields in the order as listed in Table 12-1. 

Table 12-1: Referrals tab columns and information 

Column Information 
Flag  indicator Displays when a patient has a flag. This column is always the first column and can 

only be removed by turning all flags “off” in the User Preferences. 

 The feather indicator in this column means that there is an open CMET with an 
overdue step. Go to the CMET Tracked Events sub-tab to review this condition. 

Patient Name Required field that will link to the Patient Record if you double-click it. 
HRN Patient’s health record number. The HRN will display as the HRN number followed 

by the facility code. 
Sex F (for female) or M (for male). 
Age Patient’s age. 
DOB Patient’s Date of Birth. 
Designated PCP Designated Primary Care Provider, if any. Not all facilities use this field to empanel 

patients. 
Community Patient’s community of residence. 



iCare Population Management GUI (BQI) Version 2.6 

Panel View User Manual Referrals Tab 
July 2017 

72 

Column Information 
Active DX Tags One or more predefined diagnosis definitions (“tags”) that iCare has proposed for 

the patient that has a Proposed or Active status. 
Individual 
Columns 

There are individual columns for each Reminder. 

 
You can view the Community alert text by hovering your mouse over the Community 
Alert ( ) icon, if any. The icon does not affect the sorting of the Community column. 

Double-click any row in the grid to access the Referrals tab of the Patient Record 
window. 

The default sort order is alphabetical by Patient Name. 

You can sort/filter the columns and perform other functions on the columns. 

12.2 Referrals Tab Toolbar 
The toolbar shows the date/time for which the data is effective. 

Section 14.2 provides for more information about the buttons on the right side of the 
toolbar. 

12.2.1 Copy Patient(s) 
This action copies the patient’s information to the iCare clipboard. 

Select one or more patients and then do one of the following: 

• Click the Copy Patient(s) ( ) button 

• Select Referrals | Copy Patient(s) 

• Use the keyboard combination Ctrl+C 
Go to another panel view (for a different patient panel) and paste the patient’s 
information. 

12.2.2 Layout 
The Layout function determines which referrals columns to display for the current 
panel as well as the order and sorting that should be used. 

To change the layout, do one of the following: 

• Click the Layout ( ) button 

• Select Referrals | Layout 



iCare Population Management GUI (BQI) Version 2.6 

Panel View User Manual Referrals Tab 
July 2017 

73 

The Referrals Layout screen will display for the current panel. Here you can select 
the Referrals columns you want to display on your panel. 

 
Figure 12-2: Referrals Layout window 

Section14.5 provides information about manipulating the columns the layout. 

12.3 Referrals Tab Menu Options 

12.3.1 File Menu 
The options on the File menu for the Referrals tab are the same as those on File 
menu for the Patient List tab. 

12.3.2 Tools Menu 
The options on the Tools menu for the Referrals tab are as follows: 

Quick Patient Search: This option opens the Quick Patient Search (within Panel) 
dialog. 

Mail Merge, Reset View, Refresh, Search, Excel Export, Print, Copy Rows to 
Clipboard: These options work like the buttons on the right side of the window. 
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User Preferences: This option opens the User Preferences window. 

Web Links 
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13.0 Consults Tab 
The Consults tab displays consult data for the panel of patients. 

 
Figure 13-1: Sample Consults tab 

13.1 Consults Tab Layout 
The default view displays the fields in the order as described in Table 13-1 below. 

Table 13-1: Consults tab columns and information 

Column Information 
Flag  indicator Displays when a patient has a flag. This column is always the first column and 

can only be removed by turning all flags “off” in the User Preferences. 

 The feather indicator in this column means that there is an open CMET with 
an overdue step. Go to the CMET Tracked Events sub-tab to review this 
condition. 

Patient Name Required field that will link to the Patient Record if you double-click it. 
HRN Patient’s health record number. The HRN will display as the HRN number 

followed by the facility code. 
Sex F (for female) or M (for male). 
Age Patient’s age. 
DOB Patient’s Date of Birth. 
Designated PCP Designated Primary Care Provider, if any. Not all facilities use this field to 

empanel patients. 
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Column Information 
Community Patient’s community of residence. 
Active DX Tags One or more predefined diagnosis definitions (“tags”) that iCare has proposed 

for the patient that has a Proposed or Active status. 
Individual Columns There are individual columns for each Reminder. 

 
You can view the Community alert text by hovering your mouse over the Community 
Alert ( ) icon, if any. The icon does not affect the sorting of the Community column. 

Double-click any row in the grid to access the Consults tab of the Patient Record 
window. 

The default sort order is alphabetical by Patient Name. 

You can sort/filter the columns and perform other functions on the columns. 

13.2 Consults Tab Toolbar 
The toolbar shows the date/time for which the data is effective. 

Section 14.2 provides for more information about the buttons on the right side of the 
toolbar. 

13.2.1 Copy Patient(s) 
This action copies the patient’s information to the iCare clipboard. 

Select one or more patients and then do one of the following: 

• Click the Copy Patient(s) ( ) button 

• Select Consults | Copy Patient(s) 

• Press Ctrl-C 
Go to another panel view (for a different patient panel) and paste the patient’s 
information. 

13.2.2 Layout 
The Layout function determines which consult columns to display for the current 
panel as well as the order and sorting that should be used. 

To change the layout, do one of the following: 

• Click the Layout ( ) button 

• Select Consults | Layout 
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The Consults Layout screen will display for the current panel. Here you can select 
the Consults columns you want to display on your panel. 

 
Figure 13-2: Consults Layout window 

Section14.5 provides information about manipulating the columns the layout. 

13.3 Consults Tab Menu Options 

13.3.1 File Menu 
The options on the File menu for the Consults tab are the same as those on File menu 
for the Patient List tab. 

13.3.2 Tools Menu 
The options on the Tools menu for the Consults tab are: 

Quick Patient Search: This option opens the Quick Patient Search (within Panel) 
dialog. 

Mail Merge, Reset View, Refresh, Search, Excel Export, Print, Copy Rows to 
Clipboard: These options work like the buttons on the right side of the window. 

User Preferences: This option opens the User Preferences window. 
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Web Links 
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14.0 iCare Features Used by Panel View 
The following provides information about using the iCare features for the Panel View 
window. 

14.1 User Preferences 
This section focuses on the user preferences that are used by the Panel View window. 

  
Figure 14-1: User Preferences window 

After the User Preferences window is complete, click OK and the user preferences 
will be in effect for the operation of the iCare application. (Otherwise, click Cancel.) 

14.1.1 Startup View Tab 
The selection on Startup View tab determines the tab that displays when you first 
access the iCare application. 
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Figure 14-2: Startup View tab on User Preferences 

Select the Panel View radio button if you want the Panel View with the selected 
panel name to be the first window to display when you access the iCare application. 

14.1.2 Panel View Tab 

 
Figure 14-3: Panel View tab 
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The selections on Panel View window determine the following: which tabs are 
displayed, the startup tab that displays when you first access the Panel View window, 
the view size, the default location to be associated with various clinic codes. 

Tabs: Use the Show/Hide column to determine which tabs are displayed when a 
patient is opened. Checking will display the selected tab. The Starting Tab column 
sets which tab is initially displayed when a patient is opened. At a minimum, one tab 
must be checked as Show and set as Starting tab. 

View Set: Determine the view size and selecting either the Normal or Maximized 
option button (the default is Normal). 

14.1.3 CMET Tab 
The CMET tab of User Preferences determines the Events user preferences for the 
CMET tab on the Panel View window. 

  
Figure 14-4: Panel View tab features 

The Events sub-tab displays all events that have been identified at your site in the 
routine background job. This can be a very large number of events; limit this display 
by applying filters to the view. Filtering in this manner does NOT affect the routine 
background job. 

Use the Events sub-tab to establish the filters for the current events on the CMET tab 
of the Panel View window. 

After changing the settings on the Events sub-tab, click OK to save changes 
(otherwise, click Cancel). 
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14.1.3.1 Restore to System Default Button 
Click the Restore to System Default button to return to the system default settings 
for the Events sub-tab. 

14.1.3.2 Collapse Tips Display 
Select the Collapse Filters Display check box to collapse the Tips of a particular 
sub-tab (tips will not display). This check box is available on the Events sub-tab of 
the CMET tab. 

14.1.3.3 Collapse Filters Display 
Select the Collapse Filters Display check box to collapse the Filters group box of a 
particular sub-tab (the various filters will not display). This check box is available on 
the Events sub-tab of the CMET tab. 

14.1.3.4 Status 
Use the Status field to filter the displayed events to those having a particular status 
on the Events sub-tab. Click the drop-down list and select an option to populate the 
Status field. 

14.1.3.5 Time Frame 
Use the Time Frame field to filter the displayed events to those in a particular time 
frame. Click the drop-down list and select an option to populate the Time Frame 
field. 

14.1.3.6 Category 
Use the Category field to filter the displayed events to those in one or more 
categories. 

 
Figure 14-5: Category group box 

To populate the Category field, click the Edit button to access the Add/Remove 
Events Category dialog. The default Category field contains Breast, Cervical, 
Colon, Liver, Skeletal, STI. 
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Figure 14-6: Add/Remove Events Category dialog 

Available Selections 

Use the Find field to locate a particular event category name by using the two search 
option buttons: Starts With determines what the event category name starts with and 
Contains determines any of the characters in the event category name. These option 
buttons assist when the Available Selections list is quite long. 

To move a highlighted category name from the Available Selections list to the 
Current Selections list, click Add. 

Current Selections 

Use the Find field to locate a particular event category by entering a few characters of 
the event category name. The application will scroll the list to the first found name. 

To move a highlighted category name from the Current Selections list to the 
Available Selections list, click Remove. 

The options in the Current Selections field determines the default Categories for the 
Events sub-tab on the CMET tab for the Panel View window. 

14.1.3.7 Community 
Use the Community field to filter the displayed events to those in a community either 
by taxonomy or by name. 
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Figure 14-7: Community filter fields 

Select one of the option buttons to use as a filter for the events. 

By Name Option Button 

Use the By Name option button to define the communities to filter the events. 

Use the field below the option buttons to filter the communities in the lower field. 
The options are (1) With At Least One Patient or (2) All. 

Use the Edit button to add one or more names to the lower field. Click the Edit 
button to access the Add/Remove Communities dialog. 

 
Figure 14-8: Sample Add/Remove Communities dialog 

Available Selections 

The Available Selections option determines patient population for a community by 
name. Select an option from the list to change this field. 

Available Selections List 
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Use the Find field to locate a particular community name by using the two search 
option buttons: Start With determines what the community name starts with and 
Contains determines any of the characters in the community name. These option 
buttons assist users when the Available Selections list is quite long. 

To move a highlighted community name from the Available Selections list to the 
Current Selections list, click Add. 

Current Selections 

Use the Find field to locate a particular community by entering a few characters of 
the community name. The application will scroll the list to the first found name. 

To move a highlighted community name from the Current Selections list to the 
Available Selections list, click Remove. 

The options in the Current Selections field determines the default communities for 
the Events sub-tab on the CMET tab for the Panel View window. 

When the Add/Remove Communities dialog is complete, click OK. This populates 
the lower field with the names of the communities shown in the Current Selections 
group box. (Otherwise click Cancel.) 

If the lower field contains more than one community, the Create Taxonomy button 
activates. To use the Create Taxonomy button, the user must have the iCare Editor 
(BQIZCMED) or iCare Package Manager (BQIZMGR) security key. 

 
Figure 14-9: Community group box with Create Taxonomy active 

Use the Create Taxonomy button to save the listed communities as a Community 
taxonomy. Click the Create Taxonomy button to display the Create/Update 
Community Taxonomy dialog. 
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Figure 14-10: Create/Update Community Taxonomy dialog 

Use the Community Taxonomy Name field (required) to specify a taxonomy name 
for the list of communities. Use the Brief Description and Extended Description 
fields (not required) to add other information about the taxonomy. When the dialog is 
complete, click OK (otherwise, click Cancel). 

If the user uses a duplicate taxonomy name, iCare will provide a warning that the user 
might be overwriting the user’s taxonomy. The user can overwrite (Yes), save as 
another name (No), or cancel (to return to the Create/Update Community Taxonomy 
dialog). 

If you use a unique taxonomy name, the application displays the Confirm save to 
RPMS information message: “The data will be saved to the RPMS server. Do you 
want to continue?” Click Yes to save the data to the RPMS server (otherwise click 
No).  

If you click Yes, the application displays the Community Taxonomy Create 
message stating that the community taxonomy was successfully created and that the 
panel definition will be updated to reflect the use of a taxonomy rather than a list of 
communities. (Click OK to dismiss the message). After you click OK, the list of 
names will be replaced with the name of the taxonomy (and the By Taxonomy option 
button will be selected). 

By Taxonomy Option Button 

Use the By Taxonomy option button to define the taxonomies to filter the displayed 
events. When you click the Edit button, the application displays the Add/Remove 
Community Taxonomies dialog. 
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Figure 14-11: Add/Remove Community Taxonomies dialog 

When the Add/Remove Community Taxonomies dialog is complete, click OK. The 
options in the Current Selections group box determine the default Community by 
Taxonomy for the Events on the CMET sub-tab of the Panel View window. 
(Otherwise click Cancel.) 

14.2 Buttons on Right Side of Window 
The buttons on the right side of any iCare window have the same functionality on any 
window. 

 
Figure 14-12: Buttons on right side of window 

These buttons might not be visible; in that case, click the list  button. 

The application provides hover help for each button. 

Some iCare windows might not have the Mail Merge and Glossary buttons. 

14.2.1 Reset View 

Click the Reset View ( ) button (or select Tools | Reset View) to return the current 
view to the default view. Use this feature when changing the view, such as resizing 
the column width. This is the same as using the Ctrl-R key combination. 

14.2.2 Refresh 
Click the Refresh ( ) button (or select Tools | Refresh) to update any RPMS field 
values on the current window with new data from the server. This is the same as 
pressing the F5 key on your keyboard. 
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14.2.3 Search 
You can search for data in the current grid by clicking the Search ( ) button (or by 
selecting Tools | Search or by using the Ctrl-F key combination) to display the 
Search dialog. 

 
Figure 14-13: Search dialog 

If you do NOT select the Show Additional Search Options checkbox, the search 
looks in all columns for a match. 

If you select the Show Additional Search Options checkbox, the Search dialog 
changes to show more options for the search. 

 
Figure 14-14: Search dialog with additional search options 

Type the search criteria in the Find What free-text field. The remaining fields 
determine the criteria for the search. 

Checking the Match Case checkbox will cause the search to match the case of the 
text in the Find What field. 

14.2.3.1 Look In Field 
Click the list for the Look In field to view the field options. The highlighted option 
determines what part of the window to search. 
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Figure 14-15: List options for Look In field 

What is highlighted in the upper part of the list determines the options in the lower 
part of the list. For example, if the Look In field contains All columns, then the list 
of the column names would appear in the lower part of the list. 

14.2.3.2 Match Field 
Click the list for the Match field to view the field options. 

 
Figure 14-16: List options for Match field 

The highlighted option determines which part of the Find What field will be matched 
in the search. 

14.2.3.3 Search Field 
Click the list for the Search field to view the field options. 

 
Figure 14-17: List options for Search field 

The highlighted option determines the direction of the search. 

After all fields are populated with the search criteria, click the Find Next button. 
(Otherwise, click Close.) 

If a match is found, the matching text will be highlighted (in the grid). If you want to 
continue the same search, click the Find Next button again; repeat this process as 
needed. 

If a match is not found, the Datagrid Search Results message displays. 
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Figure 14-18: Datagrid Search Results message 

Click OK to close the message and return to the Search dialog. 

14.2.4 Export to Excel 
Export the information in the grid to Excel by clicking the Export to Excel ( ) 
button (or by selecting Tools | Export to Excel or by pressing the Ctrl-E key 
combination). 

The application displays a warning message about the export. 

 
Figure 14-19: Warning message about exporting the patient data 

Click No to dismiss the warning and to exit the export process. 

Click Yes to continue the export process and display the Save As dialog. 

 
Figure 14-20: Save As dialog 

Make sure the desired location to save the file displays in the Save in field. 
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Type the name in the File name field. The system will add XLS extension to the field 
name automatically. 

Click Save (otherwise, click Cancel.) After clicking Save, the Export Panel message 
“Excel export has been created” displays when the Save command is complete; click 
OK to dismiss the message. 

When viewing the Excel document, the application provides a Confidential Patient 
Information header in the document. 

14.2.5 Mail Merge 
The iCare application provides the capability to export patient demographic data in a 
format that can be used by word processing mail-merge files. This is a Demographic 
Data Export for Letter Generation function. 

Follow these steps: 

1. Select the patients to include in the mail-merge process. 

2. Click the Mail Merge ( ) button (or select Tools | Mail Merge) to display the 
Mail Merge Export dialog. 

 
Figure 14-21: Mail Merge Export dialog 

Section 14.2 provides information about using the buttons on the right side of the 
toolbar. 

3. Click the Instructions ( ) button to display the Mail Merge Instructions 
pop-up and view the instructions for completing the mail-merge process. 
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Figure 14-22: Mail Merge Instructions pop-up 

Note that users can print the contents by clicking the Print button or selecting File | 
Print. 

Section 14.7 provides information about the File menu and buttons on the pop-up. 

14.2.6 Glossary 
Click the Glossary ( ) button (or select the particular glossary from the Help menu) 
to display the particular Glossary pop-up. The name of the Glossary pop-up varies 
according to which part of iCare currently in use. For example, if you are on the 
Reminders tab, the Reminders Glossary pop-up will display. 

14.3 Free Text Fields 
Free Text fields are fields that users can type information into; these fields do not 
have a list from which to select an option to populate them. 

An example of the Free Text field is the Panel Name field (when creating/editing a 
panel definition). 

There is a context menu to aid in editing the text. 

 
Figure 14-23: Context menu to aid in editing text 

These options operate just like those in any Windows application. 
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Undo: Removes the last edit action. 

Cut: Removes the selected text from its current position and places it on the 
clipboard. 

Copy: Copies the selected text and places it on the clipboard (the text is NOT 
removed). 

Paste: Copies the contents of the clipboard and places it in the field at the current 
cursor position. 

Delete: Removes the selected text from its current position. 

Select All: Highlights all of the text in the current field. 

14.4 Print Preview 
The Print Preview window contains several features about reviewing and printing 
the current document. 

 
Figure 14-24: Print Preview dialog 

The Print Preview window contains two panels, where the left panel displays the 
pages in the document and the right panel displays a larger version of the page 
selected in the left panel. 
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The following table provides information about the various buttons on the Print 
Preview window. 

Table 14-1: Print Preview dialog buttons and functions 

Button Description 

 
Print the contents of the document. 
Also available by selecting Print on the File menu. 

 
Use to move the red rectangular box on the selected page in the left panel. Move 
the Hand Tool to change the display in the right panel and view information in a 
particular part of a page. 
Also available by selecting Hand Tool on the Tools menu. 

 
Grab a screen capture of a specified rectangular area, which copies the area to 
the Windows clipboard. Then paste the copy in a particular field, for example, or 
another application like MS Word. 
Also available by selecting Snapshot Tools on the Tools menu. 

 
Specify the zoom magnification. Click the button and move to the area to apply 
the zoom. Right-click on the area and select the zoom magnification option from 
the context menu. 
Also available by selecting Dynamic Zoom Tool on the Tools menu. 

 
Zoom out by clicking the button in an area in the right panel (the image becomes 
smaller). 
Also available by selecting Zoom Out on the View menu. 

 
Zoom in by clicking the button in an area in the right panel (the image becomes 
larger). 
Also available by selecting Zoom In on the View menu. 

 
Display the image in the right panel at its maximum page width (usually enlarges 
the image). 
Also available by selecting Page Width on the View menu. 

 
Display the image in the right panel with no page margins showing. 
Also available by selecting Margin Width on the View menu. 

 Used to display the image and its page margins in the right panel. 
Also available by selecting the Whole Page option on the View menu. 

 
Automatically zoom out of the image in the right panel (do not click in the panel). 
Also available by selecting Zoom Out on the View menu. 

 
Automatically zoom into the image in the right panel (do not click in the panel). 
Also available by selecting Zoom In on the View menu. 

 Display all of the pages in the right panel. 
Also available by selecting Continuous on the View menu. 

 
Specify the page layout. 
Also available by selecting Page Setup on the File menu. 

 
Move through the pages in the document by using the arrow buttons on the second 
line in the toolbar. 
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Figure 14-25: Buttons used to move through the pages of the document 

The same options are available by selecting View | Go To (and on the context menu 
for the right panel). 

Use the Zoom ( ) field (or select Zoom on the View menu) to 
specify the zoom magnification for the right panel by selecting from the list. 

Use the Close button to close the Print Preview dialog. This same action is available 
by selecting File | Exit. 

Select File | Page Setup to access the Page Setup dialog. 

 
Figure 14-26: Page Setup dialog 

Use the Page group box to specify the paper size and source. 

Use the Orientation group box to specify the orientation of the output. 

Use the Margins group box to specify the various margins widths in inches. 

Click Printer to access the Printer dialog and choose the printer to output the 
contents of the document. 
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After the Page Setup dialog is complete, click OK to save the page setup options. 
(Otherwise, click Cancel.) 

14.5 Layout 
After clicking Layout on the Panel View window, the application displays the layout 
of the columns in the particular panel. 

 
Figure 14-27: Layout window 

14.5.1 Template Group Box 
When first accessing the layout dialog, the application displays the template for the 
particular patient list. 

 
Figure 14-28: Template group box for Panel Definition 

• Leave the System Default option button selected, and the application displays the 
system default columns. In this case, the Add and Remove buttons are not active 
(and users cannot change anything) on the layout dialog. 
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• Selecting the Customized option button allows users to change the columns (the 
Add and Remove buttons become active, for example). Anything changed on the 
layout dialog will be used for the Customized template. 

• Name customized templates by selecting the Template option button. This action 
causes the field with the list to activate (and the Customized and System Default 
option buttons are not selected). After adding a name, it is added to the Template 
name list. Later, you can choose which template to use during an iCare session. 

14.5.2 Display and Available Columns 
Use the Display Columns to determine which columns to display for the particular 
panel. 

 
Figure 14-29: Display and Available columns 

The listing in the Display Columns area shows the columns that will be displayed for 
your population. The column names in italics are required and cannot be removed. 

To move a highlighted column name in the Available Columns area to the list in the 
Display Columns area, click Add. This moves the column name from the left panel 
to right panel. 

Remove a highlighted column name in the Display Columns area and move it to the 
Available Columns area by clicking Remove. This moves the column name from the 
right panel to the left panel. 

Note: You cannot remove any column names in italics. 

You can determine the order the columns display in the Display Columns area by 
using the Up and Down buttons. Highlight a column name and click the appropriate 
button. You might have to click the button more than once to move it to the desired 
location. 

14.5.3 Columns to Sort 
Sort columns to arrange the items in the column in alpha-numeric order. 
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Figure 14-30: Sample Available Sorts and Sort Columns area 

To move a highlighted column name in the Available Sorts area to the list in the Sort 
Columns area, click Add. This moves the column name from the left panel to right 
panel. 

Remove a highlighted column in the Sort Columns area and move it to the Available 
Sorts area by clicking Remove. This moves the column name from the right panel to 
the left panel. 

Note: You cannot remove any column names in italics. 

14.5.4 Column Sort Order 
Use the Sort Columns area to determine which columns to sort for a particular 
window or tab. 

Determine which order the columns are sorted in the Sort Columns area by using the 
Up and Down buttons. Highlight a column name and click the appropriate button. 
You might have to click the button more than once to move it to the desired location. 
For example, if you have Gender, Patient Name, and Diagnosis Tags in the right 
column, the Gender sort is applied first, then Patient Name, and Diagnosis Tags is 
last. 

14.5.5 Switch Sort Direction 
The names of columns in the Sort Columns area show “ASC” appended to the name, 
for example, Patient Name ASC. Switch the sort order for a selected column by 
clicking the Switch Sort Direction button. In the example, the name changes to 
Patient Name DESC. You can use the Switch Sort Direction action on more than 
one column. 

14.5.6 Manually Added column 
If you choose to add the Manually Added column (under Patient | Demographics), 
it will display an indicator ( ) when a patient is manually added to the panel. 
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Figure 14-31: Layout, Patient, Demographics window 
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Figure 14-32: Manually Added column 

14.6 iCare Taxonomy Editor Function 
The iCare Taxonomy Editor holds the security key (BQIZTXED) allowing that 
person to read/edit iCare taxonomies. 

Access the iCare Taxonomy View/Edit dialog by selecting Tools | Taxonomy 
Maintenance | View/Edit Taxonomy Entries. 
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Figure 14-33: iCare Taxonomy View/Edit dialog 

Note: If you do not hold the appropriate security key, you can 
only view the information on the dialog. The following 
message displays: You do not currently have access rights 
to edit taxonomies. In order to edit taxonomy entries, you 
will need to have the iCare Taxonomy Editor security key 
(BQIZTXED) added to your RPMS user account. 

When first accessing this view/edit dialog, all parts of the tree structure will be 
collapsed. Expand one of the tree parts and find the taxonomy to edit. 

In general, select the taxonomy from the list in the left group box to view. This causes 
the Add and Remove buttons to appear in the right group box of the dialog. 

Please note that not all taxonomies can be edited. The iCare application will display a 
message on the view/edit dialog when this condition exists. Site-populated 
taxonomies can only be edited by users with appropriate access. 

The difference between the Apply and OK is that the Apply button is used when 
adding more than one taxonomy value to the iCare Taxonomy View/Edit dialog. 

14.6.1 Add Taxonomy Values 
Click the Add button to create values for a selected item in the left group box. The 
application displays the Select Taxonomy Item dialog. 



iCare Population Management GUI (BQI) Version 2.6 

Panel View User Manual iCare Features Used by Panel View 
July 2017 

102 

 
Figure 14-34: Select Taxonomy Item dialog 

Use the Search field to search for a taxonomy item. Highlight the item to add and 
click Select. The application checks to see if it is already in the system. 

• If it already exists, you receive a warning message (click OK to dismiss the 
message); after clicking OK, you return to the iCare Taxonomy View/Edit 
dialog. 

• If it does not exist, it appends the selected item to the bottom of the list. 
After you finish adding taxonomy values, click Apply to save changes. If you do 
NOT click Apply and try to move to another taxonomy or another part of the iCare 
application, the Save Taxonomy changes? information message displays, asking if 
you want to apply the changes now. In this case, click Yes to apply the changes 
(otherwise, click No). 

You can repeat adding items to various taxonomies. When you are finished using the 
iCare Taxonomy View/Edit dialog, click OK to save (otherwise, click Cancel). 

14.6.2 Remove Taxonomy Values 
To remove one or more items from the list, highlight them and click Remove. The 
Confirm taxonomy item remove message displays. Click Yes to remove the items 
(otherwise, click No). You remain on the iCare Taxonomy View/Edit dialog. 

14.6.3 View Report of All Taxonomies Button 
Click the View Report of All Taxonomies button to display the Taxonomy Report 
pop-up. 
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Figure 14-35: Taxonomy Report pop-up 

This pop-up provides information about various Taxonomy Categories (listed in 
alphabetical order). 

Section 14.7 provides information about using the File menu and buttons on the pop-
up. 

14.7 Pop-up Functionality 
Several places in iCare display pop-ups. For example, if you double-click on any row 
in the Recent Visits group box on the Cover Sheet of the Patient Record window, 
you will view a pop-up. 
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Figure 14-36: Visit Detail pop-up 

You can take the following actions on this pop-up: 

• Navigate through the information by using the scroll bar. 

• Click the Find ( ) button to access a search tool to find data in the current 
window. This button works like the Search button. 

• Click the Font ( ) button to display the Font dialog. 

 
Figure 14-37: Font dialog 

Use the Font dialog to change the font name, style, and size of the text in the pop-up 
(applies to all of the text). In addition, you can add effects like “Strikeout” and 
“Underline”—these perform like those effects in Microsoft Word. 
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Change the Script option to the see the text displayed in another language if that 
language pack is installed on your computer. If the language pack is not installed, the 
display does not change by selecting another script. 

Click OK to apply changes to the text in the current pop-up. These changes are only 
effective for the current view of the pop-up. (Otherwise, click Cancel.) 

• Click the Copy ( ) button to copy the selected text to the Windows clipboard. 

• Click the Print Preview ( ) button to view the Print Preview dialog. You 
can print the contents of the pop-up from this dialog. 

• Click the Print ( ) button to display a print dialog where you specify the 
printer to output the contents of the pop-up, the page range, and number of copies. 

The File menu contains the print actions (like the Print Preview and Print buttons), 
the Page Setup function, the find and copy functions, as well as a Close function 
(dismisses the pop-up). 

14.8 Background Jobs 
Click the Background Jobs ( ) button (or select File | Background Jobs) to 
display the Background Jobs pop-up. 

 
Figure 14-38: Sample Background Jobs pop-up 

You must dismiss the pop-up in order to use other functions in iCare. 

The File menu has the following options: 

Page Setup: This option allows you to set Margin, Paper, Layout characteristics (like 
landscape or portrait orientation), and the Printer to use. 
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Print Preview: This option displays the Print Preview dialog. 

Print: This option outputs the data in the selected rows in the grid. The application 
displays the Print Preview dialog where you can view the output. Select File | Print 
(on the dialog) to output the content. The application provides a header stating 
Confidential Patient Information for all printed panel views. 

If you do not select any rows, the application displays the following warning 
message: “You have not selected any rows to print. Do you want to proceed and print 
all rows in this view or cancel this print?” Click Yes to print all the rows. Click No to 
cancel the print function. 

Close: This option closes the Background Jobs window. 

The Edit menu has one option: Select All (used to select all of the records on the 
pop-up window). 

The Tools menu has options that have the same functions as those of the buttons on 
the right side of the toolbar. 

14.9 CMET Worksheet 
Use the Open CMET Worksheet button to access the CMET Worksheet for a 
selected event on the particular sub-tab of the CMET window. You find this button 
on the Tracked Events and Follow-up Events sub-tab on the CMET main, CMET 
tab on the Panel View, and the Tracked Events and Follow-up Events of the 
CMET tab on the Patient Record window. 

Use this worksheet to process the Care Management Events that you have chosen to 
track. Enter data related to Findings, Follow-up and Patient Notification. The Site 
parameters “Due By” default dates set by the CMET Package Manager can also be 
edited in this screen. 
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Figure 14-39: CMET Worksheet 

When the worksheet is complete, click OK (otherwise, click Cancel). 

• When you use OK, there are two cases. 
Case 1: If not all of the steps are complete, the application updates the data on 
the Tracked Events sub-tab. 

Cases 2: If all of the steps are complete, the application will display the Close 
Event information message that states: “The event is eligible for closing as all 
four steps are completed. Do you want to close the event now?” Click Yes to 
close the event. Click No to not close the event. 

If you choose to close the event (by selecting Yes on the Close Event 
message), the application displays the RPMS iCare Reason for Closing 
dialog. Select a reason for closing the event and provide a comment (required) 
about the closing. Click OK to save the reason for closing (otherwise, click 
Cancel). 

If you click OK on the Reason for Closing dialog, the application displays 
the Save to RPMS? dialog that states: “You have data changes pending. Do 
you want to save to RPMS now?” Click Yes to save the changes to RPMS. 
Click No to discard the changes. 

• When you click Cancel, there are two cases: 
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Case 1: If you did not make any changes on the worksheet, the application 
closes it. 

Case 2: If you did make changes on the worksheet, the application displays 
the Save to RPMS? dialog that states: “You have data changes pending. Do 
you want to save to RPMS now?” Click Yes to save the changes to RPMS. 
Click No to discard the changes. Click Cancel to return to the CMET 
Worksheet. 

14.9.1 Patient Demographics Group Box 
The Patient Demographics group box shows the patient’s name, HRN, Sex, Age, 
and Date of Birth (DOB). 

 
Figure 14-40: Sample Patient Demographic group box 

Note: The HRN will display as the HRN number followed by the 
facility code. 

14.9.2 1 - Event Group Box 
The data in the 1 – Event group box provides information about the event and allows 
you to change the State of the event as well as provide comments about the Event 
and/or State. In addition, you can view the audit history of the event. 

 
Figure 14-41: Sample Event group box 

State: This field defines the State of the event. 

If you populate the State field with Closed, then the Close Reason field becomes 
active where you select an option from the drop-down list that describes why you are 
closing the event. 

When an Event has a State of Closed, the other group boxes (Findings, Follow-up, 
Patient Notifications) will be inactive. 

Event Comment: Use this Free Text field to add comments about the Event. 

State Comment: Use this Free Text field to add comments about the State. 
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CMET Audit History: If you click the View label, the application will display the 
CMET Audit History pop-up. 

 
Figure 14-42: CMET Audit History pop-up 

Because multiple users work on the event, the audit history provides of a history of 
activities. Section 14.7 provides information about using the controls on the pop-up. 

State: This determines the state of the event, either Open or Closed. 

If Closed is selected, then the Close Reason field becomes active. 

If Closed is selected, this causes all of the other group boxes (2 - Findings, 3 - 
Follow-ups, 4 - Patient Notifications) to become inactive. 

Close Reason: This field is active when State = Closed. Select an option on the list 
that gives the reason for closing the event. 

14.9.3 2 - Findings Group Box 
Use the 2 – Findings group box to enter Findings data about the event. 

 
Figure 14-43: Findings group box 

Minimize this group box by clicking the collapse button in the upper left corner. This 
allows more room for viewing the other group boxes such as Follow-ups and Patient 
Notifications. 
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The Findings Due By, Result, and Follow-up Recommended? fields become 
populated when you click the Add button on the grid and save the record. 

Findings Due By: This field displays the date the findings of this event were entered 
into CMET. If this date passes without an entry, a tickler (feather icon) is generated. 

Result: This field displays the date of the result. If this field contains an underlined 
date, click on the date to display the detail of the result. For example, below is the 
Radiology Case Number Detail pop-up. Section 14.7 provides information about 
using the controls on the pop-up. 

 
Figure 14-44: Radiology Case Number Detail 

Follow-up Recommended?: This field indicates if follow-up is recommended (yes or 
no). 

14.9.3.1 Add Button 
Click the Add button to create a new Findings record. Click the Add button (or press 
F2 on the keyboard) to access the Findings dialog. 

 
Figure 14-45: Findings dialog 
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The field names followed by an asterisk (*) are required. 

Date: Click the list and select a date for the finding. 

Finding:. This is the finding associated with the event. Use an option from the list to 
populate this field. 

Interpretation: The application populates this field, based on your selection in the 
Finding field. 

Comment: Type the text of the comments about the Finding, if appropriate, in this 
Free Text field. 

Follow-up Needed: Use an option from list: Yes or No. 

Click OK to save your data on the Findings dialog. (Otherwise, click Cancel.) 

After saving the data, the application populates the grid with the record and populates 
the Last Edited (current logon user) and Last Edited By (current date) columns. 

If you selected Yes for Follow-up Needed? field on the Findings dialog and saved, 
the Follow-up Recommended? field on the grid will be populated with Yes and the 
application will automatically display the Follow-Ups dialog (where you can enter 
follow-up data). 

14.9.3.2 Delete Button 
The Delete function applies to events that had Findings entered but NOT saved. 

If you select an event that is not eligible for the Delete function, the application 
displays the message: “Unable to delete a previously saved entry. Please mark as 
‘Entered in Error’ instead.” Click OK to dismiss the message. 

Select one or more eligible Findings records you want to delete and click the Delete 
button (or press Delete on the keyboard). The application displays the Delete Row 
information message, confirming the deletion. Click Yes to delete the selected 
records. (Otherwise, click No.) 

14.9.3.3 Error Button 
Click the Error button when Findings records have been saved and you cannot delete 
them and you want to mark them as Entered in Error. 

If you select a record that is not eligible for the Error function, the application 
displays the message: “Unable to mark as ‘Entered in Error’ because the entry has not 
been saved in RPMS. Please delete the entry instead.” Click OK to dismiss the 
message. 
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Select one or more eligible Findings records and click the Error button. After using 
this function, the application places a strikethrough mark on the text of the record. 

 
Figure 14-46: Entered in Error marking 

After you save and return to the Tracked Events tab, the Result column for the event 
will be blank for the particular event. 

14.9.4 3 - Follow-ups Group Box 
Use the 3 – Follow-ups group box to add follow-up data about the event. 

 
Figure 14-47: 3 – Follow-ups group box 

The Follow-ups group box becomes active when the Follow-up Recommended? 
field (in the Findings group box) is set to Yes. 

Minimize this group box by clicking the collapse button in the upper left corner. This 
allows more room for viewing the other group box (Patient Notifications). 

Follow-up Decision Due By: Select a date from the list that indicates when the 
follow-up decision should be made. Populating the field creates a tickler (feather 
icon) for the event. In certain cases, this date is populated by the Tickler Timeframe 
set in the site parameters. You can populate this field with the date you want to take 
action on the event. 

14.9.4.1 Add Button 
Click the Add button to create a new Follow-up record. Click the Add button (or 
press the F2 button on your keyboard) to access the Follow-Ups dialog. 



iCare Population Management GUI (BQI) Version 2.6 

Panel View User Manual iCare Features Used by Panel View 
July 2017 

113 

 
Figure 14-48: Follow-Ups dialog 

The required fields are those with the asterisk after their names. 

Event: Select an option from the drop-down list that describes the Event for the 
follow-up. 

Date Due: Use the drop-down list to display a calendar from which to select the due 
date for the follow-up event. 

Comment: Use this Free Text field to add comments about the follow-up. 

Click OK to save the data on the dialog (otherwise, click Cancel). After saving, the 
follow-up record will display in the 3 - Follow-ups group box on the CMET 
Worksheet. 

14.9.4.2 Delete Button 
The Delete function applies to events that had Follow-ups entered but NOT saved. 

Select one or more eligible Follow-up records to delete and click the Delete button 
(or press Delete on your keyboard). The application displays the Delete Row 
information message, confirming the deletion. Click Yes to delete the selected 
records. Click No to not delete the records. 

14.9.4.3 Error Button 
Click the Error button when Follow-up records have been saved and you cannot 
delete them and you want to mark them as Entered in Error. 

If you select a record that is not eligible for the Error button, the application displays 
the message: “Unable to mark as ‘Entered in Error’ because the entry has not been 
saved in RPMS. Please delete the entry instead.” Click OK to dismiss the message. 

Select one or more eligible Follow-up records and click the Error button. After using 
this function, the application places a strikethrough mark on the text of the record. 
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Figure 14-49: Sample of Follow-up record marked as entered in error 

14.9.5 4 - Patient Notifications Group Box 
Use the 4 – Patient Notifications group box to add patient notification data about the 
event. 

 
Figure 14-50: Patient Notifications group box 

The Patient Notification, the final step, makes the patient aware of both the results 
and the recommendations for follow-up. Multiple types of Patient Notifications can 
be entered for each Event. 

The Patient Notifications group box becomes active when the Follow-up 
Recommended field (in the Findings group box) is set to Yes. 

Minimize this group box by clicking the collapse button in the upper left corner. This 
allows more room for viewing the Follow-ups group box. 

Notification Due By: Enter the date to have your patient notified about the results 
and recommendations of the follow-up related to this event. If this date passes 
without an entry, a tickler (feather icon) will be generated. In certain cases, this date 
is populated by the Tickler Timeframe set in the site parameters. 

14.9.5.1 Add Button 
If you do not have default clinics defined in user preferences, the application displays 
the following message: “You must select default clinics in user preferences before 
being able to enter notes.” Click OK to dismiss the message. Select Tools | User 
Preferences to access the RPMS iCare – User Preferences dialog. Go to the 
Patient View tab to enter the clinic codes. 

Click the Add button to create a new Patient Notification record. Click the Add 
button (or press F2 on your keyboard) to access the Notifications dialog. 
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Figure 14-51: Sample initial Notifications dialog 

The required fields are those with the asterisk after their names. 

Date: The default date is today’s date. Change it by clicking the list to access a 
calendar from which to select another date. 

Method: Select an option from the list that identifies the type of notification. 

Create: This button becomes active if you select “Certified Letter” or “Letter” in the 
Method field. You must have an electronic signature on file before you can use this 
function. 

If you have an electronic signature on file, click the Create button to access the Add 
TIU Note dialog. 

Comment: use this Free Text field to add any comments about the notification. 

After completing this dialog, click OK to save the data (otherwise, click Cancel). 
After saving, the notification record will display in the 4 - Patient Notifications 
group box on the CMET Worksheet. 

14.9.5.2 Delete Button 
The Delete function applies to events that had Patient Notifications entered but NOT 
saved. 

Select one or more eligible Patient Notification records to delete and click the Delete 
button (or press Delete on your keyboard). The application displays the Delete Row 
information message, confirming the deletion. Click Yes to delete the selected 
records. Click No to not delete the records. 

14.9.5.3 Error Button 
Use the Error function when Patient Notification records have been saved and you 
cannot delete them and you want to mark them as Entered in Error. 
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If you select a record that is not eligible for the Error function, the application 
displays the message: “Unable to mark as ‘Entered in Error’ because the entry has not 
been saved in RPMS. Please delete the entry instead.” Click OK to dismiss the 
message. 

Select one or more eligible Patient Notification records and click the Error button. 
After using this function, the application places a strikethrough mark on the text of 
the record. 

 
Figure 14-52: Sample Patient Notification record marked as entered in error 

14.9.5.4 Preview 
Use the Preview function to preview the letter associated with the selected Patient 
Notification record. This function only applies to records that are Letters or Certified 
Letters. 

Select the record to preview and click the Preview button. The application displays 
the Letter Preview pop-up. 

 
Figure 14-53: Radiology Case Number Detail 

The File menu has one option, Close, which closes the pop-up. 
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14.9.5.5 Print Button 
Click the Print button to output a letter in a selected record. After clicking Print, the 
application displays the Print dialog where you specify the printer, page range, 
number of copies, etc.; this dialog works like the one in Microsoft Office. 

14.10 CMET Batch Mammogram Screening Dialog 
The batch process for mammogram screenings changes the events to have a Status of 
Tracked, the Event State of Closed, and the Close Reason of Event Complete. 

 
Figure 14-54: Sample CMET Batch Mammogram Screening dialog 

After completing the dialog, click OK to save the data on the dialog. (Otherwise, 
click Cancel.) 

14.10.1 Fields on Dialog 
The required fields have the asterisk (*) following their names. 

Status: This is the status of the event (view only). 
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Event Finding: This indicates the event finding. The list contains options to 
populate/change this field. 

Finding Interpretation: This field provides the interpretation of the finding (view 
only). 

Follow-up Event: This is the follow-up event (view only). 

Follow-up In: This is the timeframe for the follow-up. The list contains options to 
populate/change this field. 

Notification Type: This is the type of patient notification for the event. Select an 
option from the drop-down list. The options on the drop-down list are defined by the 
application (sites cannot add values). 

Create: The Create button is active when the Notification Type is Letter or Certified 
Letter. This function requires that you have an electronic signature on file. Click the 
Create button to access the Add New TIU Note - Batch Mode dialog. Section 14.12 
provides for more information about this dialog. 

Notification Date: This is the date for the patient notification. The list contains a 
calendar from which to select a date. 

Event State: This shows the state of the event (view only). 

Close Reason: This is the reason why the status is closed (view only). 

Comment: Use this Free Text field to type the text of any comments pertaining to the 
mammogram screenings. 

14.10.2 Selected Events Group Box 
The Selected Events group box contains the selected patients for batch processing 
(these are the events you selected for the process). This is read-only information. 

 
Figure 14-55: Sample Selected Events group box 

14.11 CMET Batch Pap Smear Dialog 
The batch process for pap smears changes the events to have a Status of Tracked, the 
Event State of Closed, and the Close Reason of Event Complete. 
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Figure 14-56: Sample Batch Pap Smear dialog 

After completing the dialog, click OK to save the data. (Otherwise, click Cancel.) 

14.11.1 Fields on Dialog 
The fields with the asterisk (*) following the name are required. 

Status: This field displays the status of the event (view only). 

Event Finding: This indicates the event finding (view only). 

Finding Interpretation: This provides the interpretation of the finding (view only). 

Follow-up Event: This displays the follow-up event (view only). 

Follow-up In: This is the timeframe for the follow-up. The list contains options to 
populate/change this field. 

Notification Type: This is the type of patient notification for the event. Select an 
option from the list. The options on the list are defined by the application (sites 
cannot add values). 
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Create: The Create button is active when the Notification Type is Letter or Certified 
Letter. This function requires that you have an electronic signature on file. Click the 
Create button to access the Add New TIU Note - Batch Mode dialog. Section 14.12 
provides for more information about this dialog. 

Notification Date: This is the date for the patient notification. The list contains a 
calendar from which to select a date. 

Event State: This shows the state of the event (view only). 

Close Reason: This is the reason the status is closed (view only). 

Comment: Use this Free Text field to enter the text of any comments pertaining to 
the pap smear screenings. 

14.11.2 Selected Events Group Box 
The Selected Events group box contains the selected patients for batch processing 
(these are the events you selected for the process). This is read-only information. 

 
Figure 14-57: Sample Selected Events group box 

14.12 Add TIU Note – Batch Mode 
The following information provides information about using the Add TIU Note 
dialog. 

When you click the Add Note button, the application displays the Add a Note dialog. 

After clicking the Create button on the Add a Note dialog, the application displays 
the Add TIU Note dialog. 



iCare Population Management GUI (BQI) Version 2.6 

Panel View User Manual iCare Features Used by Panel View 
July 2017 

121 

 
Figure 14-58: Add TIU Note dialog 

Both fields are required. 

Document Title: Select an option from the list to establish the title of the TIU note. 

Subject: Use this Free Text Field to enter the subject of the TIU note. This field 
becomes active after populating the Document Title field. 

At this point, you can do one of the following: not use a template or use a template. 

14.12.1 Note with No Template 
When you do not want to use a template, and after you populate the Document Title 
and Subject fields, you can type the text of the TIU note in Free Text area on the right 
side of the dialog. 

When the text is complete, the following buttons are active: Find, Font, Copy, Save 
Note, Sign Note, Close. Section 14.7 provides for more information. 

14.12.1.1 Find Button 
The Find button works like the Find button on the pop-up. Section 14.7 provides 
information about the pop-up window. 

14.12.1.2 Font Button 
The Font button works like the Font button on the pop-up. Section 14.7 provides 
information about the pop-up window. 

14.12.1.3 Copy Button 
The Copy button works like the Copy button on the pop-up. Section 14.7 provides 
information about the pop-up window. 
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14.12.1.4 Save Note Button 
Use the Save Note button to save the current note. Below is an example of what 
happens after you click the Save Note button. 

 
Figure 14-59: Add TIU Note dialog with note information 

14.12.1.5 Sign Note 
Click the Sign Note button to electronically sign the selected unsigned TIU note. 
After clicking the Sign Note button (or selecting File | Sign Note), the application 
displays the Enter Electronic Signature dialog. 

 
Figure 14-60: Enter Electronic Signature dialog 

Enter your electronic signature in the field and click OK (otherwise, click Cancel). 
After clicking OK, you return to the Add TIU Note dialog. The text of the note 
shows that the note has been electronically signed. 
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Figure 14-61: Electronic signature noted on text of TIU note 

14.12.1.6 Close 
Use the Close button to close the Add TIU Note (for patient) dialog. Click the Close 
button (or select File | Close) to close the dialog. 

14.12.2 Note with Template 
After you populate the Document Title and Subject fields, select the Show 
Template? check box. This action shows the available templates that you can use. 
(You will need to expand the Shared Templates option.) After you find the template 
to use, double-click its name. The application will display the particular template. 

 
Figure 14-62: Sample Template 

Complete the template by using the Free Text fields, check boxes, date fields, etc. on 
the template. What you select/enter on the template determines the text of the TIU 
note. 

Use the Preview button (on the Template window) to preview the note, in its current 
state. 
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Figure 14-63: Template Preview of the TIU note 

What appears on the Template Preview pop-up determines what will be in the text of 
your TIU note. After you close (File | Close) the pop-up, you return to the Template 
window. Section 14.7 provides information about using the controls on the Preview 
window. 

After completing the Template window, click OK (otherwise, click Cancel). Clicking 
OK returns you to the Add TIU dialog. 

14.12.2.1 Buttons on Add TIU Note Dialog 
Please note the following about the text of the TIU note: 

• Line lengths should be less than 80 columns (characters), otherwise, the line 
spacing on the finished TIU note will not format correctly. 

• The Find, Font, Copy, Print Preview, and Print buttons on this dialog work like 
those on the pop-up window. Section 14.7 provides information about using the 
controls on the pop-up. 

• Adjust the font size before saving the TIU note, if needed. 
Delete Note: Use this button to delete the current unsigned note. (This button does 
not apply to signed notes.) 

Save Note: Use this button to save the current note. After clicking this button, the 
note is saved and the Delete Note and Edit Note buttons become active. 

Sign Note: Use this button to electronically sign the selected unsigned TIU note. 
After clicking the Sign Note button (or selecting File | Sign Note), the application 
displays the Enter Electronic Signature dialog. 
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Figure 14-64: Enter Electronic Signature dialog 

Enter your electronic signature in the field and click OK (otherwise, click Cancel). 
After clicking OK, you return to the Add TIU Note dialog. The text of the note 
shows that the note has been electronically signed. 

 
Figure 14-65: Electronic signature noted on text of TIU note 

Edit Note: After you click the Edit Note button, the application displays the text of 
the note. 

 
Figure 14-66: Example of text of the note 

After you edit the text of the note, you can click the Save Note button again. 

If you have already signed the TIU note, you cannot change the text; you can only 
view the text. 

Close: Use this button to close the Add TIU Note (for patient) dialog. Click the 
Close button (or select File | Close) to close the dialog. 

You return to the Add a Note dialog, with the Preview button next to the Add Note 
field. 
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Figure 14-67: Add a Note dialog with Preview button 

Click the Preview button to display the text of the note. 

 
Figure 14-68: Sample Letter Preview pop-up 

Close the pop-up to return to the Add a Note dialog (with the Preview button on it). 

After the Add a Note dialog is complete, click OK (otherwise, click Cancel). 

After clicking OK, the application displays the Enter Electronic Signature dialog. 

 
Figure 14-69: Enter Electronic Signature dialog 
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Enter your electronic signature in the free text field. After completing the dialog, 
click OK (otherwise, click Cancel). 

• If you enter an invalid electronic signature and click OK, the application displays 
the Invalid Attempt information message: “Invalid electronic signature. Try 
again?” Click Retry to return to the Enter Electronic Signature dialog. Click 
Cancel, and the application displays the message: “Unable to save with a signed 
note.” Click OK to return to the Add a Note dialog. 

• If you click Cancel, the application displays the message: “Unable to save with a 
signed note.” Click OK to dismiss the message. 

• If you enter a valid electronic signature and click OK, the application displays the 
information message: “This data will be saved to the RPMS server. Do you want 
to continue?” Click Yes to save and continue. Click No to not save and leave the 
dialog. 

14.13 Erroneously Tracked Events 
Once an event has been Tracked, it cannot be changed to Not Tracked. The following 
process is used when you Tracked an event in error. 

1. Go to the Tracked tab and open a CMET worksheet for the event erroneously 
tracked. Click the Add button in the Findings area to access the Findings dialog. 

 
Figure 14-70: Findings dialog populated 

Choose the option “ERROR/DISREGARD” in the Findings field. Choose the 
option No in the Follow-Up Needed? field. It is recommended you use today’s 
date for the Date field. Click OK to save and close the dialog. 

2. Go to the Patient Notifications area of the CMET Worksheet and click Add. The 
application displays the Notifications dialog. 
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Figure 14-71: Notifications dialog populated 

Use the option NONE for the Method field. It is recommended you add a 
comment in the Comment field and use today’s date for the Date field. Click OK 
to save and close the dialog. 

3. The application will display the Close Event information message. 

 
Figure 14-72: Close Event information message 

Click Yes on the message. This closes the message. 

4. The application will display the RPMS iCare – Reason for Closing dialog. 

 
Figure 14-73: RPMS iCare – Reason for Closing dialog 
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Select the option Other for the Reason field. Enter a comment in the Comment 
field. Click OK to save and close the dialog. 

5. The application will display the Confirm save to RPMS information message. 

 
Figure 14-74: Confirm save to RPMS information message 

Click Yes on the message to save the data to RPMS and close the message. 

This process causes the particular event to have a State of CLOSED. 
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Glossary 

Context Menu 
The menu of options that displays when you right-click on an entity. 

Designated Primary Care Provider (DPCP) 
In RPMS, the provider name that is assigned as the primary care physician for 
a patient or group of patients at a specific facility. This is not a required 
function. 

Free Text Field 
A field where the user can type text, just like typing a note to someone. 

iCare Package Manager 
The designated person with authority to manage all information settings for 
iCare. 

Panel List 
The list of patient panels owned by the user. 

Providers 
Any staff member in an I/T/U facility who provides direct healthcare to 
patients, e.g. general practice or specialty physicians, registered nurses, social 
workers, physician assistants, etc. 

Within RPMS, the term “provider” has different specific meanings. See 
definitions for Designated Primary Care Provider (DPCP); Primary Provider; 
Visit Providers. 

Reminders 
Health Maintenance Reminders review patient data and alert the provider to 
procedures that might be overdue for the patient. Reminders can be based on 
age and gender and include typical clinical prevention measures, such as pap 
smears. 

Tagging 
A process to review the patient’s data and categorize (“tag”) the patient with 
one or more clinical diagnoses, such as Known CVD or Diabetes. Tags will be 
used to provide more accurate reminders that are prioritized more 
appropriately for a patient’s multiple conditions. 
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Taxonomy 
In RPMS, a grouping of functionally related data elements, such as ICD 
codes, that are created and maintained within the RPMS Taxonomy Setup 
application. Taxonomies will be used as definitions for diagnoses, procedures, 
lab tests, medications, and other clinical data types. 

If you need a change or addition to an existing taxonomy, please see your 
CRS coordinator. 

Tooltip/Hover Help 
A common GUI element used to provide additional information to users. To 
display a Tooltip, hover the mouse pointer, without clicking, over a column 
heading or field. 

Visit Provider 
In RPMS, the provider(s) who cared for a patient on a specific visit. Each 
patient visit must have at least a primary provider entered. Visits can also have 
one or more secondary providers. The primary visit provider might or might 
not be the same provider as the patient’s DPCP, and can change on each visit, 
depending on the visit type or the clinic staffing. 
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Acronym List 

Acronym Term Meaning 
BQI Namespace for iCare 
CMET Care Management Event Tracking 
CQM Clinical Quality Measures 
CRS Clinical Reporting System 
DPCP Designated Primary Care Provider 
EHR Electronic Health Record 
GPRA Government Performance and Results Act 
GUI Graphical User Interface 
HHS Health and Human Services 
ICD International Classification of Diseases 
IHS Indian Health Service 
IPC Improving Patient Care 
I/T/U Indian Health Service, or Tribal or Urban Indian health 

programs 
OIT Office of Information Technology 
PM Performance Measures 
RPMS Resource and Patient Management System 
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Contact Information 

If you have any questions or comments regarding this distribution, please contact the 
OIT Help Desk (IHS). 

Phone: (888) 830-7280 (toll free) 
Web: http://www.ihs.gov/helpdesk/ 
Email: support@ihs.gov 

http://www.ihs.gov/helpdesk/
mailto:support@ihs.gov
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